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Chapter 1

UNIVERGE® SV9100

Introduction

PC Programming, referred to as PCPro, is an application used to manage the 
SV9100 system. PCPro is rich with features to help users more easily manage a 
chassis when compared to handset programming.

The user can perform the following when using PCPro:

 Upload/Download settings between PCPro and a chassis.

 Save settings to files that can be archived for later use. 

 Program settings grouped by their relationship via standard screens. 

 Generate reports that can be used to monitor settings.

 Automatically update chassis firmware remotely.

 Export settings to files for later use.

 Capture low level messages to problem solve through the Debug Terminal.
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Chapter 2

UNIVERGE® SV9100

Installation

SECTION 1 SYSTEM REQUIREMENTS

The process of installing PCPro is straight-forward. Just run the installation program 
and follow the instructions. Table 2-1 System Requirements lists the minimum 
system requirements necessary for install PCPro on your computer.       

SECTION 2 DEFAULT PCPRO ACCOUNTS

When installing PCPro for the first time, the installation program creates a set of 
default PCPro accounts. The accounts with the user name and password to access 
these accounts are provided in Table 2-2 Default PCPro Accounts.   

Table 2-1  System Requirements

System: Minimum Requirements

CPU
CPU and Memory are dependent on the Microsoft Operating System 
environment used.

Memory

OS Vista, Windows 7 (32/64bit), Windows 8/8.1

Other Microsoft Internet Explorer 7.0/8.0/9.0/10.0

Communication port LAN, Modem or ISDN

Disk Space 1GB for PCPro (minimum)

TCP Port

PCPro must have TCP port 8000 open between the chassis and the 
host PC. Communications between PCPro and the chassis occurs 
on this port when uploading / downloading via LAN.
The PCPro TCP port is 8000 at default, but this can be changed 
through the Administration>WebPro Settings section of WebPro 
using PRG 90-54-02. PRG 90-54-02 is not accessible from 
telephone programming or PCPro.
The port to be used for debug should be defined in 10-20-06.

Table 2-2  Default PCPro Accounts

User Name Password Access Level

necii 47544 Manufacturer Mode (MF)
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In addition, the installation program will create the following default folders:  

tech 12345678 Installer Mode (IN)

ADMIN1 0000 System Administrator Mode 1 (SA)

ADMIN2 9999 System Administrator Mode 2 (SB)

NOTE


An install/uninstall does not remove or modify any existing PCPro Accounts, or 
Connection Accounts.

Table 2-3  Default Folders

Folder Name/Icon Location Description

My Databases <install dir>\databases
Default folder where PCPro databases 
are saved.

DebugTerm <install dir>\logfiles
Default folder where PCPro Debug 
Terminal log files are saved.

Reports <install dir>\reports
Default folder where PCPro reports are 
saved.

exports <install dir>\exports
Default folder where PCPro exported 
files are saved.

NOTE


An install/uninstall does notresult in the folder or any files in the folder being 
deleted.

Table 2-2  Default PCPro Accounts

User Name Password Access Level
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SECTION 3 SOFTWARE INSTALLATION

The software can be installed from the application CD, provided with the chassis or 
downloaded from the web. 

1. Launch the installer.

If installing from a CD, the CD should autorun.  When the splash screen is
displayed, select Install Software.

If downloading from the website, copy the file to your computer and launch the 
installer.

2. When the installer launches, the InstallShield Wizard Welcome screen is
displayed.  Press Next>.

If you do not want to continue, click Cancel to abort the installation and exit the
software.

NOTE


If the software does not autorun, you can open the CD and select setup.exe.

Figure 2-1  InstallShield Wizard Welcome Screen
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3. The next screen is displayed indicating the default location where the files
reside on your computer.

If the default location is where you want the files located, click Next>.  Refer to
Figure 2-2 InstallShield Wizard Destination Folder (Default Location).

If you want to change the location where the files are located, click Change.
Refer to Figure 2-3 InstallShield Wizard Destination Folder (Change Location).

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the
software.

Figure 2-2  InstallShield Wizard Destination Folder (Default Location)
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Figure 2-3  InstallShield Wizard Destination Folder (Change Location)
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4. To install the program, click Install.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the
software.

Figure 2-4  InstallShield Wizard Begin Installation
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5. The program installs.  Figure 2-5 InstallShield Wizard Installation Progress
shows the screen you will see that indicates the progress of the installation.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the
software.

Figure 2-5  InstallShield Wizard Installation Progress
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6. When the installation is completed, Figure 2-6 InstallShield Wizard Finish
Installation is displayed.  Click Finish.

Figure 2-6  InstallShield Wizard Finish Installation
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SECTION 4 LAUNCHING THE APPLICATION SOFTWARE

Once the application software has successfully installed you can launch the 
application in one of two ways:

 Click the PCPro shortcut icon that was placed on your desktop during installation.  

-- OR --

 Select the program by clicking Start > All Programs > NEC > SV9100 PCPro > 
SV9100 PCPro. 

Figure 2-7  SV9100 PCPro Desktop Shortcut

Figure 2-8  InstallShield Wizard Launch Software
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SECTION 5 LOGGING INTO THE APPLICATION

After you have launched the application, you must login using the User Name and 
Password.  Refer to Table 2-2 Default PCPro Accounts on page 2-1 for a list of 
default PCPro accounts and their associated user names and passwords. 

1. Enter the appropriate User Name and Password and press OK.

If you do not want to continue, click Cancel to abort login and exit the software.

Figure 2-9  PCPro Login Screen
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2. If the login is successful, the PCPro Welcome screen is displayed.

Figure 2-10  PCPro Main Menu
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Chapter 3

UNIVERGE® SV9100

Application Layout

SECTION 1 INTRODUCTION

The programming section of PCPro provides methods to view and edit values 
associated with a chassis configuration.  Most programming is done using two 
different views: Standard and System Data. These methods can be accessed 
through the menu item Programming.  Accessing these items updates the 
applications Sub-menu and Workspace areas. The Status bar gives a status 
indication of various functions related to PCPro (e.g., connection status, version 
information).

The general PCPro application layout is shown in Figure 3-1 PCPro Application 
Layout.

Figure 3-1  PCPro Application Layout

Ribbon Bar

Submenu Status Bar Workspace

 



ISSUE 2.0
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SECTION 2 MENU

The menu displays the list of functions available in PCPro. Some of these commands 
have images next to them so you can quickly associate the command with the image. 
The full list of the PCPro menu hierarchy is found in  - Menu and Toolbar Reference.

SECTION 3 TOOLBAR

The Toolbar is not opened by default. It is opened by going to View. The Toolbar is a 
group of buttons that map to items in the application menu. The toolbar allows for 
quick and convenient access to the most common PCPro commands. The items on 
the toolbar are shown in Figure 3-2 PCPro Toolbar.     

The full list of the PCPro menu and toolbar hierarchy is found in  - Menu and Toolbar 
Reference.

SECTION 4 SUB-MENU AREA

The Sub-menu area is used to navigate through Standard View (refer to  - Standard 
View) and System Data (refer to  - System Data View). Selections made from the 
sub-menu area updates the workspace with the related settings.

NOTE


The keyboard shortcuts (where applicable) are listed below the toolbar 
identification in Figure 3-2 PCPro Toolbar.

Figure 3-2  PCPro Toolbar

File New
(Ctrl+N)

File Open
(Ctrl+O)

File Save
(Ctrl+S)

Standard View
(F9)

Easy View
(F10)

System Data Programing
(F11)

Search
(F3)

Connect/Disconnect

Download
(F6) (Ctrl+D)

Upload
(F7) (Ctrl+U)

Modification 
History Report

System Data Reports

Verify
(F8)

Debug Capture

Navigation 
Filters

Help
(F1)

Configure Blade
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SECTION 5 WORKSPACE

The Workspace is where all programming occurs. The Workspace consists of 
various selections made from the Sub-menu Area and the Workspace itself. 
Common Workspace components are further explained.  

Figure 3-3  PCPro Workspace

Title
Subtitle

Workspace Buttons

Data Area

Navigation Area

Help Area
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5.1 Title

Title describes what the current settings in the Workspace are related to. This is 
associated with the selection made in the Submenu Area. The title is situated at 
the top left corner of the Workspace.

5.2 Subtitle

Subtitle shows further information about what the you are programming.

5.3 Workspace Buttons

The Workspace buttons area displays different buttons relevant to current 
programming. These buttons include:   

Table 3-1  Workspace Buttons 

Button Description

Apply sets changes recently made on the active screen. Attempting 
to apply an invalid value prompts a validation message detailing the 
error.  In this case, changes are not applied until the value is made 
valid.

Default Cell sets all highlighted cells back to the default program 
setting. 

Paste applies copied contents into the selected location.

Copy shows the Copy dialog. Refer to  - Copy for more information.

Default resets the active screen to the system default values.

Form View is the default view, which displays the values with pull 
down boxes. Note that this option is not available on all screens.
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When you do not click the Apply button, but do one of the following, the system 
applies the changes as if you had clicked the Apply button.

 Attempt to leave the current screen.

 Attempt to navigate a different item within the system data.

 Use the Previous button.

 Use the Next button.

 Save the active configuration.

 Exit the application. (Note that on some screens, the system prompts you to 
save the changes or to exit without saving them.)

 Generate a report.

Grid View is available on screens that have a large number of 
values that must be entered (e.g., screens with telephone 
extensions). When Grid View is selected, the screen switches to a 
table format, allowing you to easily enter a large number of values 
for a specified extension.

For example, if assigning your incoming virtual ring tones for internal 
extensions, you can switch from Form View to Grid View to list all of 
the extensions in table format. Note that this option is not available 
on all screens.

Table 3-1  Workspace Buttons  (Continued)

Button Description
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5.4 Navigation Area

To navigate to different items within a program, use the various navigation 
buttons.  

Figure 3-4  PCPro Navigation Buttons

Select an item to view

Move to the previous item

Move to the next item

Navigation Filters

Move to specified items

Table 3-2  Navigational Buttons and Drop Down List

Button/Menu Description

Selections Select the item from the drop down list. PCPro 
automatically moves to the selected item.

Ranges Use this button to select a range of values.  Type in the 
value and press the ‘Go’ button (magnifying glass icon) 
or press Enter.  PCPro displays a range of available 
items, beginning with the value you typed.  For 
example, if you typed Station Port 300, PCPro displays 
a range of ports beginning with port 300.

Previous/Next Use Previous to show settings of the preceding item.
Use Next to show settings of the next item.
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5.5 Data Area

The Data Area is where actual system data appears. The contents of this area are 
specific to what the you are programming. For example, if programming PRG 
10-02, this area shows all the data items within 10-02.

The contents of the Data Area are linked to the various system data views 
available. These are:

 Standard

 Easy Edit

 System Data

5.6 Help Area

The Help Area shows help text relevant for the data in the Data Area. More 
extensive help can usually be found in the application online help (F1 key).

5.7 Status Bar

The status bar, which is a horizontal area at the bottom of the Workspace, 
provides information about the current state of what you are viewing in the 
Workspace and any other contextual information.    

Figure 3-5  PCPro Status Bar

PCPro Account User 
Name And Access LevelDescription

of Menu Area

Site Name and 
Connection Type

PCPro File 
Version

Chassis CPU 
Version

System Data 
Modification 

Indicator
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Chapter 4

UNIVERGE® SV9100

Standard View

SECTION 1 OVERVIEW

Standard View combines related settings into one screen, allowing a quick setup of a 
high level task. Settings on these screens work together, allowing you to understand 
how settings relate to each other. Standard screens are identified by their name. This 
name indicates the tasks with which the screen is related. 

Figure 4-1  Standard View Submenu

This menu displays by right 
clicking on the Standard View 

window.
Window View: Right click to display 
the flyout, which allows you to select 

how you want the Standard 
submenu displayed.  

Auto Hide: Clicking this icon hides 
the Standard submenu list and 

docks the tabs on the left side of 
the screen.

Close: Clicking this icon closes 
the Standard submenu list and 

tabs. 
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SECTION 2 STANDARD VIEW SUBMENU

2.1 Accessing Standard View

You can access Standard View submenu area using any of the following 
methods: 

 From the Standard View submenu, select the menu item View > Standard.

  -- or --

 Select the toolbar icon (by clicking View) depicting the purple cog .

    -- or --

 Press F9.

 -- or --

 If the submenu area is currently open, select the Standard tab depicting the 
purple cog icon.  

Once selected, the Standard View menu appears in the Programming submenu 
area. Standard screens are listed alphabetically.

To view a particular Standard View screen, click on the screen name. 

Figure 4-2  Selecting a Standard View Screen
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2.2 Using a Standard View Screen

Each Standard View screen works differently. However the following common 
methods apply:

1. Select the Standard View screen from the Standard View menu
relevant to the desired task.

2. Modify settings on the screen.

3. Press the Apply button to save the changes.

The method in modifying settings for each screen is explained in the help 
menu.

The remainder of this chapter discusses the individual options available from 
the Standard View submenu.  

SECTION 3 CARD CONFIGURATION

The screen represents a conceptual model of the chassis and the blade packages 
within it. To obtain blade details download the configuration from the chassis. The 
blade slots display the blade types (these are the blades that can be inserted in the 
selected slot), the telephone/trunk port range (these are the ports used by the blade) 
and firmware version (firmware being used by the blade). By default, all blade slots 
displayed as white indicating no blade has been installed in that slot.  

On this screen, you can right mouse click on the desired slot. A popup menu is 
displayed indicating the configurable options for that slot. Once you have selected 
the blade that is installed in that slot, the blade name is displayed on the front of the 
slot location.  

Refer to Figure 4-3 Standard View Card (Blade) Configuration Screen on page 4-4 
for the layout of the Card Configuration screen.
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Figure 4-3  Standard View Card (Blade) Configuration Screen
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3.1 Blade Types

In PCPro, blade types are categorized under the following four groups. When you 
right click on the chassis model on the screen, the popup menu is displayed. The 
menu lists the blades and each blade type is designated with a distinctive color.   

Telephone
Represented on the Blade Configuration screen as 'blue' blades. Telephone 
blades provide interfaces to telephones being used in the chassis. Telephone 
blades use telephone ports (e.g., a GCD-8DLCA makes use of eight telephone 
ports).

Trunk
Represented on the Blade Configuration screen as 'yellow' blades. Trunk blades 
provide interfaces to lines such as COI, DID, OPX, BRI, PRI, T1, CCIS, etc., 
which are being used in the chassis. Trunk blades, use trunk ports (e.g., a 
GCD-4COTB blade makes use of four trunk ports).

Combo
Represented on the Blade Configuration screen as 'yellow/blue' blades. Trunk 
blades provide interfaces to lines such as digital single line stations, which are 
being used in the chassis. Combo blades, use telephone ports (e.g., a GCD-LTA 
blade makes use of eight digital telephone ports and two analog ports).

Other
Represented on the Blade Configuration screen as 'green' blades. These 
miscellaneous blades do not have a direct relationship to a trunk or telephone. 
However, some blades under this category (e.g., GCD-VM00) use telephone 
ports as they are associated with extensions.

3.2 Adding a Blade

To add a blade, complete the following steps:

1. With the mouse, right click on the slot where you want the blade to
reside.

2. A popup menu appears listing the blade types that can be installed.

Blade Type and Color

NOTE


There are two additional options on the popup menu. These are 
Configure Card and Delete Card.   These two options are only available 
if a blade has previously been added.
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3. Select a blade type relevant to the blade to install.

4. Another popup menu appears listing blades associated with the
selected blade type.

5. Select the desired blade package you want to add.

The slot changes appearances to indicate the blade that is installed, the firmware 
version, the port type and the port range that is used.

3.3 Removing a Blade

To remove a blade, complete the following steps:

1. With the mouse, right click on the blade you want to remove.

2. When the popup menu is displayed, select Delete Card.

The blade is removed and the slot and port type range it was utilizing is now 
available for use by another blade.

3.4  Assigning IP Phones to ETIA Blades

To assign an IP to an ETIA blade, complete the following steps:

1. Click on the IP to ETIA button.

2. Right click on the IP phone to assign it to the ETIA blade.

3. Select the ETIA blade to which the IP phone is connected.

IMPORTANT

❍ Selecting External Hub means the phone is not connected to
an ETIA blade.

❍ Set the phone type using PRG 15-05-26 to ensure the correct
power factor is assigned by the system.
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4. Click OK to save your selection.

Figure 4-4  Connect IP Terminals to ETIA Blades
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SECTION 4 SYSTEM INSTALLATION

The System Installation screen allows you to assign initial settings for the SV9100 
system.    

Figure 4-5  Standard View System Installation

1) Select Country
and time zone.

2) Assign Connection
Settings.

3) Assign Night Mode Switching.4) Assign music source.

6) Assign local area and
preferred carrier codes.

7) Assign extension
numbers.

 



ISSUE 2.0

SV9100 PC Programming Manual 4-9

To assign the initial system settings:

1. Select the Country (United States or Canada) and GMT Time (appropriate
time zone) where the system installed.

2. Assign the IP Address, Subnet Mask, Default Gateway, Optimum Baudrate
and SMDR Output as required for the installation site.

3. Assign whether the system automatically switches to Night Mode. If you select
Automatic Night Mode Switching, you also need assign the time the system
switches to day mode (Day Mode Switch Time) and to night mode (Night
Mode Switch Time).

4. Use the pulldown menus to disable Music on Hold or Background Music, or
assign the music source.

5. Select InMail if this is the voice mail that the system uses.

6. Assign the Local Area Code and Preferred Carrier Code.

7. Assign extension numbers for virtual, operator, Music on Hold ACI extension
and Background Music ACI extensions. Also assign the Voice Mail Pilot
extension. The Current Extension Plan for the assigned extensions is displayed
(this field is view only).
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SECTION 5 TELEPHONE SETUP

This screen combines system data, which is relevant for telephone settings. It allows 
you to assign basic telephone settings.    

Figure 4-6  Standard View Telephone Setup

Highlight the areas for multi-assignment and right mouse click to open the MultiAssign dialog box.

2~7)  Assign the appropriate 
telephone setup options.

1) Select the ICM Extension
to view.
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To assign the basic telephone settings.

1. Use the ICM Extension pulldown menu to select a specific extension you want
to view.  The selected extension is highlighted.

2. Assign the Name (Extension Name) that is displayed.

3. Assign a Dep Grp (Department Group) to the selected telephone for incoming
ringing priority.

4. Assign the Int Page Grp (Internal Paging Group) selected telephone to an
internal paging group (e.g., to assign the telephone paging zones and to
specify whether the telephone can receive internal all call paging).

5. Assign Day-Toll Restr (Day Mode Toll Restriction) class for Day Mode.

6. Assign Night-Toll Restr (Night Mode Toll Restriction) for Night Mode.

7. Assign Hol-Toll Restr (Holiday Mode Toll Restriction) for Holiday Mode.

8. Use the pulldown menu to assign Off Hk Rng (Off-Hook Ringing) to the
extension.

9. Enable/Disable Rng Ln Pref (Ringing Line Preference) for the extension.

10. Enable/Disable Trk Ln Pref (Trunk Line Preference) for the extension.

11. Click Apply to save the settings.

MultiAssignment

Telephones the have the same properties can be assigned in a block by using the 
MultiAssign feature. 

IMPORTANT

The extension name cannot be multi-assigned.
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To assign properties to a block of telephones:   

1. Select the area of cells to be assigned in a block.

2. Right click the mouse within the selected area. The MultiAssign dialog box is
displayed. (Refer to Figure 4-6 Standard View Telephone Setup on page 4-10.)

The MultiAssign dialog is filled with the values from the top most selected lines.
If any cells on that line are disabled, the default value for that item is used.
Columns that are not selected are disabled.

3. Make your selections and click OK. All selected telephones are assigned the
values in the MultiAssign dialog box.

Figure 4-7  Standard View Telephone Setup MultiAssign Dialog
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SECTION 6 CLASS OF SERVICE FOR TELEPHONES

This screen combines system data relevant to Class of Service Options for 
telephones. 

Figure 4-8  Standard View Class of Service for Telephones

1) Select Class of Service

2) Enable/Disable
services for Class.

3) Select Night Mode.

4) Select telephones
using this Class of
Service Night Mode.
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The assign Class of Service settings for telephones:

1. Select the Class of Service (1~15) you want to assign to the telephones.

2. Enable/Disable telephone-specific service options for the selected Class of
Service. These settings are linked with programs 20-07, 20-08, 20-09, 20-10,
20-11, 20-12 and 20-13.

3. Select the Night Mode from the pulldown menu.

4. Click the telephones that you want to assign to the specified Night Mode.

The selected telephones will be members of the class during the selected Night
Mode. These settings are linked with 20-06.

5. Click Apply to save the settings.

NOTE


You can select one of three options for viewing the services:  

  Show all services.

      -- or --

  Show only enabled services.

      -- or --

  Show only disabled services.

You can also choose how you want to view the options:

  Categorized (by program)  

     -- or --

  Alphabetic (by feature name)  
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SECTION 7 CLASS OF SERVICE FOR DISA/E&M TIE LINES

This screen combines system data relevant to Class of Service options for DISA 
users and E&M Tie Lines.   

To assign Class of Service options for DISA and E&M Tie Lines.

1. Select the Class of Service (1~15) you want to assign to the telephones.

2. Enable/Disable telephone-specific service options for the selected Class of
Service. These settings are linked with programs 20-14.

Figure 4-9  Standard View Class of Service for DISA/E&M Tie Lines

1) Select Class of Service.

2) Enable/Disable
services for Class.

3) Select Night Mode.

4) Select DISA users
and Tie Lines using
Class of Service for
Night Mode.
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3. Select the Night Mode from the pulldown menu.

4. Click the DISA users and E&M Tie Lines that you want to assign to the
specified Night Mode.

The selected DISA users and E&M Tie Lines will be members of the class
during the selected Night Mode. DISA settings are linked with program 25-09
and E&M Tie Line settings are linked with program 34-02.

5. Click Apply to save the settings.

NOTE


You can select one of three options for viewing the services:  

  Show all services.

      -- or --

  Show only enabled services.

     -- or --

  Show only disabled services.

You can also choose how you want to view the options:

  Categorized (by program)  

     -- or --

  Alphabetic (by feature name)
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SECTION 8 DEPARTMENT GROUPS

This screen combines system data relevant to the feature Department Groups.   

Figure 4-10  Standard View Department Groups

1) Select Department
Group.

3) Select Primary
Members.

2) Set up basic
characteristics of
selected Department
Group.

4) Set priority for
Primary Members.

5) Select Secondary
Members (max. 16).

6) Set priority for
Secondary Members.
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To setup up a Department Group:  

1. Specify a Department Group to modify.

2. Specify basic characteristics (Basic Settings) of the Department Group.

The Basic Settings section basic characteristics of the selected Department
Group. These settings are linked with 16-01.

3. Select the extensions that are Primary Members of the Department Group.

All extensions that are Primary Members of the selected Department Group are
listed.  Every extension must belong to one of the 64 available Department
Groups. By default, all extensions are Primary Members of Department Group
1. By removing an extension from Department Group 1 it is automatically
assigned to Department Group 64. These settings are linked with 16-02.

4. Specify the priority for the selected Primary Members.

When an extension is selected as a Primary Member it automatically appears
in the priority list (the list to the bottom of the Primary Member list). The priority
of the selected extension can be modified by the following key combinations:

 Shift + Up Arrow Increase priority by 1

 Shift + Down Arrow Decrease priority by 1

 Shift + Page Up Increase priority by one page

 Shift + Page Down Decrease priority by one page

 Shift + Home Make highest priority

 Shift + End Make lowest priority

5. Select the extensions (maximum of 16) that are Secondary Members of the
Department Group.

All extensions that are Secondary Members of the selected Department Group
are listed. A maximum of 16 extensions can be assigned as Secondary
Members. These settings are linked with 16-03.

6. Specify the priority for the selected Secondary Members.

7. When an extension is selected as a Secondary Member it automatically
appears in the priority list (the list to the bottom of the Secondary Member list).
The priority of the selected extension can be modified by using the same key
combinations as in the case of setting the priority for Primary Members.
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SECTION 9 DID TRANSLATION TABLE

This screen combines system data relevant to the DID Translation Table and Trunk 
Groups using DID. These settings are used with the feature “Direct Inward Dialing”. 

Figure 4-11  Standard View DID Translation Table

6) Set Trunk Group
specific DID settings.

5) Select which Trunk
Groups use the selected
DID Table area.

1) Set up DID Table Area.
Specify the entry range in
the global translation table.
Use the right mouse button
to edit the ranges.

2) Set the entries for
the selected area.

4) Set Intercept Ring
Group for selected DID
Table area.

3) Select Night Mode.
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To setup the DID Translation Table and associate it with Trunk Groups:

1. Select and define a Table Area within the DID Translation Table.

The DID Translation Table consists of 4000 entries that can be divided among
20 Table Areas, each being made up of a 1st and 2nd Area. Using the mouse,
right click a Table Area to define its 1st and 2nd entry ranges it uses. These
settings are linked with 22-10.

When a Table Area is selected, the grid to the right is updated with the new 
entry range. For example, selecting Area 01, 1st Area (entry ranges 001~100) 
will result in the grid showing the DID Table entries 001 to 100.

2. Specify the selected Table Area entries and how they are treated with DID.

Table Area entries are located in the grid to the right of the Table Area list. It
defines DID Table Area entries and how they are directed within the system.
These settings are linked with 22-11.

3. Select the Night Mode to modify for DID.

Assign the Trunk Groups that use the Table Area via this Night Mode selection.
In addition, use this to help define the Intercept Ring Group calls get forward to
during Night Modes. Do this by completing the following:

 Select a Night Mode.

 Select the Trunk Groups during this Night Mode that will use the selected Table
Area.

Figure 4-12  Standard View DID Table Area Edit Popups

1) Use the right mouse
button to show the popup.

2) Specify the entry ranges for
1st and 2nd areas.
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 Define the Intercept Ring Group calls that are forwarded during this Night
Mode.

4. Specify the Intercept Ring Group to use by the Table Area during the selected
Night Mode.

Specifies if the call, during the selected Night Mode, is directed toward an
Incoming Ring Group or voice mail. This setting only applies when the option is
enabled in the associated DID Translation Table entry. This setting is linked
with 22-12.

5. Select the Trunk Groups that use the Table Area during the selected Night
Mode.

This section lists the Trunk Groups that use the Table Area for DID during the
selected Night Mode. These settings are linked with 22-13.

6. Specify the DID settings for the selected Trunk Group.

The basic setup details for the Trunk Group DID settings are selected in this
section. These settings are linked with 22-09.
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SECTION 10 NIGHT MODE SWITCHING

This screen combines system data relevant to the Chassis feature “Night Service”.   

To setup the Night Mode Switching options:

1. Enable/disable users from activating Night Mode Service via a service code.

This selection enables/disables users from activating Night Mode Service via a
service code. This setting is linked with 12-01-01.

Figure 4-13  Standard View Night Mode Switching

1) Enable/Disable
Night Mode Service
Code activation.

2) Enable/Disable
Night Mode Service.

3) Select Service
Group to modify.

5) Specify Schedule
Pattern applied to
each day of week.

6) Assign names to
each mode.

4) Set up the
Schedule Patterns.

7) Specify holidays
in Service Group.

8) Specify trunks that
use this Service Code.

9) Specify extensions that
use this Service Group.
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This is a system-wide setting and is applied across ALL Service Groups.

2. Enable/disable Automatic Night Mode Service.

This selection enables/disables Night Mode Service for the system. This setting
is linked with 12-01-01.

This is a system-wide setting and is applied across ALL Service Groups.

3. Specify a Night Mode Service Group (1~32) to modify.

4. Define Schedule Patterns used by the selected Night Mode Service Group.
Schedule Patterns are comprised of time frames that are associated to Night
Modes.

You can define up to 10 Schedule Patterns for the selected Night Mode Service
Group. Schedule Patterns can be made up of 20 time frames. Each time frame
is associated with a Night Mode. These settings are linked with 12-03.

Refer to 10.1 Adding a Time Frame on page 4-24, 10.2 Removing a Time
Frame on page 4-25, 10.3 Moving a Time Frame on page 4-25 and 10.4
Modifying a Time Frame on page 4-26.

5. Specify the Service Patterns applied to each day of the week.

Define the Schedule Pattern used each day of the week by the selected Night
Mode Service Group. These settings are linked with 12-03.

6. Assign a name to each Night Mode.

This can be used to identify the time frame. Night Mode names defined here
are referred to throughout the system. These settings are linked to 12-07.

7. Define public holidays and the Schedule Pattern used by the Night Mode
Service Group on these days.

These settings are linked with 12-04.

8. Select the trunks that are members of the Night Mode Service Group.

These settings are linked with 12-06.

9. Select the extensions that are members of the Night Mode Service Group.

These settings are linked with 12-05.
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10.1 Adding a Time Frame

This section describes how to add a time frame to a schedule for night mode 
switching. 

 To add a time frame in a Schedule:

1. Using the mouse on the Schedule Pattern bar, left click and drag from
the starting time toward the end time. A colored bar appears defining
this time frame. Keep the left mouse button pressed while dragging.

2. Release the left mouse button. A dialog then prompts for the Night
Mode associated with this time frame.

3. Select a Night Mode associated with this time frame.

The colored bar changes its color depending on the Night Mode
defined.

Each mode is assigned a different color. These colors are shown in
Figure 4-15 Standard View Night Mode Switching Mode Colors on page
4-25.

Figure 4-14  Standard View Night Mode Switching Adding Time Frame

Move the left mouse button 
over the slider area until an up/
down arrow is displayed,  While 
holding down the left mouse 
button, move the slider to the 
desired position and release the 
mouse button to set the time.  

Release the 
mouse button 
when finished.

The Mode Selection dialog box 
is displayed when the time 
frame has been selected.  
Select the desired mode from 
the pull down selection menu.

Popup 
indicating 

duration and 
Night Mode.
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10.2 Removing a Time Frame

To remove a time frame, select it then drag it either left or right off the Schedule 
Pattern bar. Alternatively, select the time frame and press the Delete key.

10.3 Moving a Time Frame

To move a time frame select it with the mouse and drag it to the desired position. 
Surrounding time frames can limit changes because time frames cannot overlap. 
To solve this problem either remove time frames or modify them.

Figure 4-15  Standard View Night Mode Switching Mode Colors

Mode 7

Mode 6

Mode 8

Mode 5

Mode 4

Mode 3

Mode 2

Mode 1
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10.4 Modifying a Time Frame

To modify a time frame in a Schedule Pattern:

1. Select the time frame to modify.

2. Place the cursor at the top/bottom of the time frame until it changes
appearance.

3. Left click then drag from the starting/ending time to the desired change.

10.5 Time Frame Duration

To find out the duration of a time frame select it and then hold down the left mouse 
button. A popup appears indicating the duration and Night Mode.

10.6 Time Frame Night Mode

To find out the Night Mode of a time frame select it and then hold down the left 
mouse button. A popup appears indicating the duration and Night Mode.

 CAUTION

Surrounding time frames can limit changes because time frames 
cannot overlap. To solve this problem either remove existing time 
frames or modify them.
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SECTION 11 INCOMING RING GROUPS

This screen combines system data relevant to the feature “Incoming Ring Groups”. 

To setup up an Incoming Ring Group:

1. For each trunk, specify the Incoming Ring Group of which it will be a member.
Alternatively, route the call from the trunk to a voice mail type. Individual
settings can be applied to each Night Mode.

These settings are linked with 22-05.

2. Select the incoming Ring Group to which the trunks and extensions are
assigned.  You can use the right and left arrows to select the previous or next
Ring Group (1~100).

3. Select the extensions that are members of the Incoming Ring Group.

These settings are linked with 22-04.

Figure 4-16  Standard View Incoming Ring Groups

1) Place each trunk
in a Ring Group or set
the trunk to terminate
on voice mail instead
of a Ring Group.

2) Select the Ring
Group.

3) Select which
extensions are in the
Ring Group.
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SECTION 12 SYSTEM TIMERS

This screen allows you to set up system-wide timers.  

The settings that can be changed on this screen include the individual timers.

To change the timer settings from the default:

1. Click the value to the right of the time you want to change.

2. Change the timer setting and click Apply.

Figure 4-17  Standard View System Timers

1) Make necessary
changes to the timers.

2) Click Apply.
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SECTION 13 SYSTEM TIMER CLASSES

This screen combines system data relevant to Timer Classes. Timer Classes detail 
sets of operation times. Trunks and extensions can be assigned as members of 
these classes for each of the system Night Modes.  

Figure 4-18  Standard View System Timer Classes

1) Select Time Class.

2) Set various Timers
in the class.

4) Specify which trunks use
this timer class for the
specified Night Mode.

3) Select Night
Mode.

5) Specify which extensions
use this timer class for the
specified Night Mode.
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The settings that can be changed on this screen include:

 Time Class: The Timer Class to which timers are assigned.

 Night Mode: The Night Mode assigned for night mode switching.

 Timers: The system wide timers that can be changed.

 Trunks/Telephone: Lists the trunks/telephones that are members of the class
during the selected Night Mode.

 Extensions: Lists the extensions that are members of the class during the
selected Night Mode.

To setup up a Timer Class complete the following:

1. Specify a Time Class (1~15) to modify.

2. Set the various timers for the specified Time Class.

These settings are linked with 20-31. (All times are in expressed in seconds.)

3. Select a Night Mode.

4. Select the trunks/telephones that are members of the Time Class during the
selected Night Mode.

These settings are linked with 20-30.

5. Select the telephone extension that will use members of the Time Class during
the selected Night Mode. A different Time Class can be set to each Night Mode.

These settings are linked with 20-29.
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SECTION 14 TRUNK ACCESS MAP

This screen combines system data relevant to the Trunk Access Map. The Trunk 
Access Map administers the usage of trunks by the extension. Extensions can be 
assigned to one of the 400 Access Maps for each of the system Night Modes. 

Figure 4-19  Standard View Trunk Access Map

1) Select the Trunk
Access Map.

2) Select the Night
Mode.

3) Specify the type of access for each trunk.  Use the right mouse button
to display the types of access.

4) Select which extensions
are in the Trunk Access
Map for the specified Night
Mode.
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To setup a Trunk Access Map complete the following: 

1. Specify a trunk Access Map (1~400) to modify.

2. Select a Night Mode.

3. Specify the access type for each trunk using the Trunk Access Map.

To modify the access type, right click the trunk then select an access type from
the popup menu. These settings are linked with 14-07.

The various access types are listed below:

4. Select the extensions that use the Trunk Access Map during the selected Night
Mode.

These settings are linked with 15-06.

Access Type Image

No access

Outgoing access only

Incoming access only

Access only when trunk on hold

Outgoing access when trunk on hold

Incoming access when trunk on hold

Incoming/outgoing access

Incoming/outgoing access when trunk on hold
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SECTION 15 TRUNK GROUPS

This screen combines system data relevant to Trunk Groups. Trunk Groups prioritize 
the use of a group of trunks. Priority of Trunk Groups can be done via the Route 
Table. A Route Table entry can then be used by trunks and extensions.   

Figure 4-20  Standard View Trunk Groups

1) Add trunks to the
Trunk Group.

2) Assign priorities to
the trunks in the
Trunk Group.

3) Set up the Route
Table.

4) Select the Route Table
and the Night Mode.

5 & 6)  Specify the extensions that use 
the selected Route Table.

7) Specify the trunks that use
the selected Route Table.
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To setup a Trunk group complete the following: 

1. Specify a Trunk Group (1~100) entry to modify.

2. Select the trunks that are members of the Trunk Group.

These settings are linked with 14-05-01.

3. Prioritize trunks by ordering them in preference.

These settings are linked with 14-05-02.

When a trunk is selected as part of the Trunk Group it automatically appears in
the priority list (the list to the bottom of the Trunk Group list). The priority of the
selected trunk can be modified using the following key combinations:

 Shift + Up Arrow Increase priority by 1

 Shift + Down Arrow Decrease priority by 1

 Shift + Page Up Increase priority by one page

 Shift + Page Down Decrease priority by one page

 Shift + Home Make highest priority

 Shift + End Make lowest priority

4. To setup a Route Table entry:

This entry defines four destinations where the Route Table entry directs calls.
Calls can terminate on a Trunk Group or flow on to another entry in the Route
Table.

Destinations are prioritized 1~4 with 1 being the highest and 4 being the lowest.
These settings are linked with 14-06.

5. To assign the extensions and trunks that use the Route Table Entry, select a
Route Table (1~100) and a Night Mode.

6. Select the extensions that use the Route Table entry during the selected Night
Mode.

This applies to extensions using the Trunk Service Code to access trunks.
These settings are linked with 21-02.

7. Select the extensions, during this Night Mode, that use the Route Table entry
via the alternate Trunk Access Code.

This applies to extensions using the alternate Trunk Service Code to access
trunks. These settings are linked with 21-15.

8. Select the trunks, during this Night Mode, that use the Route Table entry.

These settings are linked with 21-03.
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Chapter 5

UNIVERGE® SV9100

Easy Edit

SECTION 1 OVERVIEW

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.  

Figure 5-1  Easy Edit Submenu

Window View: Clicking this icon 
displays the flyout, which allows you 

to select how you want the Easy 
Edit submenu displayed.  Right 

mouse clicking also displays this 
menu.

Auto Hide: Clicking this icon hides 
the Easy Edit submenu list and 

docks the tabs on the left side of 
the screen.

Close: Clicking this icon closes 
the Easy Edit submenu list and 

tabs. 

 



ISSUE 2.0

5-2 Easy Edit

SECTION 2 ACCESSING EASY EDIT VIEW

To access Easy Edit View complete one of the following:

 Select View Tab > Easy Edit.

-- or --

 Press F12.

-- or --

 If the Easy Edit submenu area is currently open, select the Easy Edit tab
depicting the magic wand, located at the bottom on the submenu.

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.
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SECTION 3 SEARCHING FOR A FEATURE

You can use the search function of Easy Edit to locate a specific feature or use a 
keyword to find a group of related features. The example below shows entering the 
exact feature name to locate the feature and entering a keyword to locate a group of 
similar features. Start the search by either pressing the magnifying glass icon or 
pressing Enter.   

SECTION 4 PROGRAMMING LEVELS

There are three levels in which feature programming is grouped.  You can apply 
program filters to system data programming: 

 Level 1 – are the most commonly assigned programs for a feature.

 Level 2 – are the next most commonly assigned programs for a feature.

 Level 3 – are programs that are not often assigned for a particular feature and 
require an expert level working knowledge of the system to be properly 
assigned.  

To show the level of programming for a feature:

1. Press the desired level to view the programs assigned at that level.

2. Select a feature.

Level 1 Level 2 Level 3
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SECTION 5 USING EASY EDIT

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.  

5.1 Filter Bar

Filtering adds the ability to filter an easy edit page on any settable value for the 
selected column. Clicking on the Filter Bar icon will enable this feature.  

Figure 5-2  Easy Edit Tab

Figure 5-3  Filter Bar
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After the filter bar is displayed any value can be entered as a filter for a column. In 
the example below, the station name column was filtered for “10”, so any name 
that contains 10 will be shown. You can filter multiple columns for different values 
as needed.

Once in the Column array, data can be grouped using the Group Bar. To return the 
page back to default click on the “Default” icon.  

Figure 5-4  Column Filter Example
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5.2 Group By

The Group By option adds the ability to sort displayed data on an easy edit page 
by any of the setting options for that page, or by any settable value for the 
selected column. Clicking on the Group by icon will enable this feature.    

To set group by options, simply click on the Group By option. Then drag a column 
heading into the group by area to use that as a grouping option. Grouping options 
are set as priority in the order they were added. In the example below, the 
grouping is first done by Message Waiting Lamp LED Color, then by Extension 
number. Grouping can be done as needed in any order and by as many options 
as there are columns on a particular page.

The Expand All and Contract All features are used to expand or contract all 
grouping.

Once grouped, data can be filtered using the Filter Bar. To return the page back to 
default, simply click on the “Default” icon.   

Figure 5-5  Group By Option

Figure 5-6  Group By Message Waiting Lamp LED Color Example
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5.3 Column Chooser

The Column Chooser allows the customization of pages to display only the 
desired columns. Clicking the Column Chooser icon will bring up a window to 
which columns can be dragged in and out of. To remove a column, click the 
heading and drag it to the Column Chooser window. To add a column click the 
heading and drag it into the Column array area.

Once in the Column array area columns can be filtered using the Filter Bar or 
grouped using the Group Bar. Columns can also be moved as needed by clicking 
and holding the column title then dragging it to the desired position. The order of a 
column can be changed from high to low or low to high. For instance, the 
extension column can start with extension 101 at the top or with extension 3961. 
To change the order click on the column title box, an arrow will appear in that box 
that when clicked will change to sort order for that column.

To return the page back to default simply click on the “Default” icon.  

Figure 5-7  Column Chooser Example
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5.4 Save State

Once modified, Easy Edit pages can be saved so the same options are displayed 
each time that page is opened. The current view state of the Easy Edit page as 
set is saved and is displayed each time you enter the page. You must also save 
the database to retain this setting on exit. To return the page back to default click 
on the “Default” icon and choose to Save State again.   

Settings remembered:

• Column Chooser

• Group By

• Filter Bar enabled or disabled

• Column width

• Column order

Settings not remembered:

• Filter strings

Figure 5-8  Save State Example
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5.5 Grid Style and Custom Themes

In addition to the old controls on the new ribbon bar, the ‘Grid style’ has been 
added to use a predefined theme, create a custom theme, or edit an existing 
theme. This allows the simple selection of six color themes and to make your own 
theme and save to six custom slots.

There are many color and gradient options for the grid including color/gradient 
attributes for each grid area such as odd/even rows, groups, header, selection 
and others. This allows users to select the scheme that best suits them.

There are six predefined themes that can be used to change the colors used to 
highlight column information. In addition six custom themes can be created. There 
are many color and gradient options for the grid including color/gradient attributes 
for each grid area such as odd/even rows, groups, header, selection and others. 
This allows users to select or create the scheme that best suits them.  

Any aspect provided by the grid theme can be changed using the ‘Theme edit’ 
panel. First select the Item from the dropdown list. Either the color picker will 
enable or the gradient spin control.

There are no less than 46 different areas that a color or gradient can be chosen 
for on the grid.

• Selected cell colors

• Odd and even row colors

• Header

• Grid lines

• Background

• Left offset

Figure 5-9  Save State Example
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Selected header colors Each with a setting for:

• Background

• Text

• Border

• Gradient color

• Gradient angle

• Grid Lines or no grid lines.

The range of colors follows the colors supported by the user’s PC.  

The initial box contains 125 colors and 25 grays, but clicking the ‘Other colors’ 
button will bring up the color picker from which the user can even use the ‘Select’ 
pipette and touch anywhere on their screen to pick up the color.  

Figure 5-10  Color Selection Example

Figure 5-11  Choosing the Color Picker
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To save a custom theme, choose one of the undefined themes, make changes as 
desired, then check the “Save Custom” box when finished. A predefined theme 
can be changed and by checking the “Save Custom” will over-write the default 
settings for the selected theme.  

Figure 5-12  Saving a Custom Theme
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Chapter 6

UNIVERGE® SV9100

PCPro SD Card Copy

SECTION 1 OVERVIEW

The SD card copy is used to migrate from an S (1GB) SD Drive to the larger E (4GB) 
SD Drive-based system, and is also used if replacing the GCD-CP10 for any reason. 
See below for details on using and what data is moved for each mode.

There are two modes to use:

 Standard to migrate from an S (1GB) SD Drive to the larger E (4GB) SD Drive-
based system.

 Advanced when replacing a GCD-CP10 with a SD Drive of the same size.

1.1 Standard Mode

Standard Mode copy is used when migrating from an S (1GB) SD Drive to an E 
(4GB) SD Drive. Only the following items are migrated using this process and 
none are optional:

1. System Database: The system database as programmed, the same
information as a database backup.

2. License Data: Any licenses that have been applied to the system but note
the built in 48 resource licenses are not moved.

3. InMail Messages: Stored voice mail messages.

4. InMail Greetings: Recorded user greetings.

1. To copy the old SD Drive data SD Card Copy from the Home tab under
Maintenance choose SD card copy.
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2. Choose Standard Mode.

3. When Prompted, choose the originating drive from the pull down menu and
click OK.
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4. The copy process starts.

5. Once the copy process has finished, click OK, then click on Close.
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6. Safely eject the old SD Card from Windows.

7. Insert the destination SC Card into the PC.

8. Click on Copy SD Card.

9. When prompted, choose the destination drive from the pull down menu.

10. When Prompted, click on Yes to start copying data to the new SC drive. The
Copy Data options are fixed for Standard Mode copy and cannot be
changed. Note - the destination SD is prepared by PC Pro before the copy
will start and this process can take a several minutes.
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11. Once the copy process completes, click on OK.

12. Click on Close to close the copy window.
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1.2 Advanced Mode

Advanced Mode copy is used if a SD Drive is being replaced with a new SD drive 
of the same size, either an S (1GB) or E (4GB). The items below are selectable 
options when using Advanced Mode copy.

 System Database – The system database as programmed, the same 
information as a database backup.

 License Data – Any licenses that have been applied to the system.

 InMail Messages – Stored voice mail messages.

 InMail Greetings – Recorded user greetings.

 Main System software – The system software on the SD Card to be copied, for 
example v1.70.00. If this option is not selected, the software installed on the 
destination GCD-CP10 will be used.

1. To copy the old SD Drive data SD Card Copy from the Home tab under
Maintenance, choose SD card copy.

2. Choose Advanced Mode.

3. Click on Read SD Card.
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4. When prompted, choose the originating drive from the pull down menu, then
click OK.

5. Once the copy process finishes, click on OK, then click on Close.

 



ISSUE 2.0

SV9100 PC Programming Manual 6-9

6. Safely eject the old SD Card from Windows.

7. Insert the destination SD Drive into the PC.

8. Click on Copy SD card. The window that comes up allows for items to be
selected or deselected as needed. All of the choices are optional:

 System Database: The system database as programmed, the same 
information as would be included in a database backup.

 License Data: Any licenses that have been applied to the system.

 InMail Messages: Saved voice mail messages.

 InMail Greetings: Recorded user greetings.

 Main System software: The system software on the SD Card to be 
copied, for example v1.70.00. If this option is not selected the software 
installed on the destination GCD-CP10 will be used. If this option is 
selected the software version of the originating SD Drive will be used on 
the new system.   

9. Select the desired option(s).

10. Choose the destination drive from the pull down menu, then click OK.
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11. When prompted, click on Yes to start copying data to the new SD drive.

Note the destination SD is prepared by PC Pro before copying starts and this 
process can take several minutes.  
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Depending on the options selected, the Advanced copy can go much faster. The 
largest data to move is always the InMail messages and greetings.  

12. Once the process has completed, click on OK.
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13. Click on Close to close the copy window.
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Chapter 7

UNIVERGE® SV9100

System Data View

SECTION 1 OVERVIEW

System Data represent systems settings as per the categorization used by main 
software. This categorization separates settings into System Data items called 
‘PRGs’ (programs). PRGs are identified by their ID and name. The ID and name 
indicate what settings the System Data is related to. An example of a PRG identifier 
can be seen below, ‘10-02’ is the ID and ‘Location Setup’ is the name:

10-02: Location Setup

PRGs are grouped by their relationship into ‘PRG Groups’. PRG Groups are 
identified by their ID and name. The ID and Name indicate what settings the System 
Data is related to. An example of a PRG identifier can be seen below, ‘10-XX’ is the 
ID and ‘System Configuration’ is the name:

10-XX: System Configuration

Since System Data Programming does not group together the programs for a 
function/feature as with Easy Edit and Standard screens, System Data Programming 
is intended for advanced users of PCPro who are very familiar with programming a 
system. 
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Figure 7-1  System Data Submenu

Auto Hide: Clicking this icon hides 
the System Data submenu list and 
docks the tabs on the left side of 

the screen.

Close: Clicking this icon closes 
the System Data submenu list 

and tabs. 
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SECTION 2 ACCESSING SYSTEM DATA VIEW

To access System Data View, complete one of the following:

 Select the menu item View > System Data.

 -- or --

 Select the toolbar icon depicting the blue block .

 -- or --

 Press F11.

 -- or --

 If the Programming submenu area is currently open, select the System Data tab 
depicting the blue box, located at the bottom on the submenu.    

The System Data View Menu appears in the submenu area. System Data is grouped 
by PRG Groups and ordered numerically by ID. You can use the Expand All to view 
all of the items under each Program Number or Collapse All to return to the numeric 
program listing. You can individually expand or collapse a program number pressing 

or .  
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SECTION 3 SEARCHING FOR A PROGRAM

You can use the search function of Program Data to locate a specific program or use 
a keyword to find a group of related programs. The example below shows entering a 
program number to locate a specific program and entering a keyword to locate a 
group of similar programs. Start the search by either pressing the magnifying glass 
icon or pressing Enter.   

SECTION 4 SYSTEM DATA PROGRAM FILTERING

When selecting programs from the system data list, you can select from the following 
filters:

 – shows all system data.

 – shows only unsaved system data.

 – show only system data that needs to be uploaded.

 – shows only system data that is unsaved and needs to be uploaded.

 



ISSUE 2.0

SV9100 PC Programming Manual 7-5

To show the level of programming for a feature:

1. Select a program.

2. Press the desired filter and view the filtered programs.

SECTION 5 USING SYSTEM DATA

System Data screens are intended for advanced users who are very familiar with 
using PCPro. If you are not familiar with PCPro, you should use either the Standard 
View or Easy Edit. Standard View and Easy Edit are grouped together to help guide 
you through system data necessary for programming various features of the system. 

Filter 2 Filter 3 Filter 4Filter 1
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Figure 7-2  System Data Programming

Pull down menu to 
changed system data 
item being viewed. 

View Previous 
item. 

View Next 
item. 

Filter

Mouse over for 
help information.

2) Modify system
data items.

1) Select system
data.
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To modify system data:

1. Select a PRG from the System Data View submenu.

2. Modify the desired settings on the screen.

3. Press the Apply button to save the changes.

When programming system data, changes are applied:

 when the Apply button is pressed.

 when the you change the system data item link.

 when you modify the current system data item filter.

 when you exit System Data View, except when the Cancel button is pressed.
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Chapter 8

UNIVERGE® SV9100

Menu and Toolbar Reference 

SECTION 1 OVERVIEW

This chapter provides a table that can be used as a reference between the menus, 
toolbar icons and keyboard shortcuts. Most functions have more than one method for 
accessing it. Any sub-menus are listed with their associated menu. 

SECTION 2 MENUS AND TOOLBARS

The menu (located at the top of the screen) allows access to a list of functions 
provided by PCPro.   The toolbar provides a graphical icon interface to some of the 
more commonly used functions.

Figure 8-1  Menu and Toolbar

Menu (default)

Toolbar
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Table 8-1 Menus lists the menu options, provides a brief description of the menu and 
shows an graphical representation of the menu display. Some menu items have a 
flyout, indicated by the , which provides additional options for that selection.

Table 8-1  Menus 

Menu Description Menu Display

File This  menu provides access to:
 functions related to creating 

and saving files

 sending  an e-mail with an 
active configuration attached

 displaying the properties for 
an active configuration

 allowing users to log off and 
log in as a different user

 exiting PCPro

View This menu allows you to:
 show/hide the Toolbar

 show/hide the Status Bar

 show/hide the Tool Tips

 show/hide the Submenu Area

Home This menu provides access to:
 Connect/Disconnect to PCPro

 Upload/Download files

 Go to Interactive Menu items

 view/edit blade configurations

 set the system time

 make multiple assignments 
for Account Codes, 
Appearance Keys, 
Extensions, and Function 
Keys

 Run Scripts

 Configure PCPro Accounts

 PCPro configuration settings

 Create software files

 Upgrade software files

 Feature activation

 Verify

 SD Card copying
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Reports This menu allows you to 
various reports on system 
settings:
 Class of Service settings

 Alarm status

 History of modifications

 Non default values settings

 Numbering Plan settings

 System configuration settings

 System Data settings

 Feature Activation

 VSlot

 Import DID Tables and Speed 
Dial numbers

 Export DID Tables, Speed 
Dial numbers and DESI 
Labels

Filter This  menu allows you to filter 
by:
 IP Phone list

 Mobile Extension list

 Unused Phone list

 Unregistered Phones

 Unused Trunk list

 Unregistered Trunk list

 Filter by Extension

 Filter by Trunk

Tools This menu provides access to:
 Initialize the System

 Launch the Debug Terminal

 DIM File download

Table 8-1  Menus  (Continued)

Menu Description Menu Display
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Help This  menu provides access to:
 online documentation

 register your PCPro software

 display the application 
version, the version and 
copyright date for the main 
software to which PCPro is 
connected

Table 8-1  Menus  (Continued)

Menu Description Menu Display
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Table 8-2 Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference 
provides a list of the main menu items listed on the menu bar. Any associated 
sub-menus are listed in the Sub-menu Level 1, Sub-menu Level 2 and Sub-menu 
Level 3 columns. If a toolbar icon or shortcut key is available for the menu item, it is 
listed in the Toolbar Icon and Shortcut Key Sequence columns.  

Table 8-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference 

Main Menu Item
Sub-menu Level 

1 Item
Sub-menu Level 2 

Item
Sub-menu Level 3 

Item
Toolbar

Icon

Shortcut 
Key 

Sequence

File New SV9100 North America SV9100 R1.0
Ctrl + N

Open…
Ctrl + O

Save
Ctrl + S

Save As…

Send

Properties

Log off

Exit
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Table 8-3  Toolbar Menus and Sub-Toolbar Menus

Home

Communications Programming Multi Assign Scripts Accounts Maintenance

Disconnect Cards (Blades)

Multi 
Assign

Account Code

Run 
Scripts

PCPro 
Accounts

Create Software File

Download Time setting Call Appearance 
Keys

PCPro 
Configuration

Upgrade Software

Upload DID Feature Activation

Interactive Extension 
Number

Verify

Function Key SD Card Copy

View

View General System Data

System data Tool Bar Tool tips Display (5-10-20-30)

Standard Status Bar

Navigation

Report

Reports Import Export

Class of service DID table DID tables

Alarms Speed dial Speed dials

Modification 
History

DESI Labels

Non default values

Numbering plan

System 
Configuration

System data

Feature activation

VSlot

Filter 
Options

Unregistered Phones Unregistered Trunks Filters

IP Phone list Unused trunk list Extension

Mobile Extension list Trunks

Unused phone list
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Tools

System

System initialize

Debug terminal

DIM file download

Manufacturer Tools

Ribbon Scripts

Default Dump DB

Save to XML

Load external
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Appendix A

UNIVERGE® SV9100

MultiAssign

SECTION 1 OVERVIEW

To shorten the time needed to program certain system data, PCPro provides a series 
of special purpose dialogs. These dialogs enable you to set multiple values with 
ease.

SECTION 2 ACCESSING MULTIASSIGN DIALOGS

To access the various dialogs available for the MultiAssign option, select Home > 
MultiAssign from the toolbar (refer to Figure A-1 Accessing the MultiAssign Dialogs 
on page A-1).  Select the desired option for assigning:

 Account Codes

 Call Appearance Keys

 Direct Inward Dialing 

 Extension Numbers

 Function Keys

Figure A-1  Accessing the MultiAssign Dialogs
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SECTION 3 ASSIGNING ACCOUNT CODES

The Account Codes multi-assignment dialog enables the user to set a range of 
account codes. This saves valuable time over having to enter each account code 
individually.

The Account Codes dialog box is accessed by selecting Home > MultiAssign > 
Account Codes from the toolbar. 

To assign a range of account code BINs with numbers:

1. Specify the begin/end BIN range over which to iterate.

2. Specify the account code number to being the assignment.

3. Specify by how much each account code is to be incremented. For example, a
value of 2 means accounts codes will increment by 2 for each BIN (i.e. 0001,
0003, 0005…).

4. Click the Apply button to trigger the assignment.

Figure A-2  MultiAssign Account Codes

1) Specify
Account Code
BIN range.

2) Specify Account
Code number with
which to begin
assignment.

3) Specify the
number indicating
how much to
increment each
Account Code.

4) Click Apply to assign the
specified Account Codes.
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Example

To assign BINs 001 ~ 010 with account codes 00001 ~ 00019 in increments of 2:

1. Place a 1 in the Begin at Verified Account Code Bin edit box.

2. Place a 10 in the End at Verified Account Code Bin edit box.

3. Place 00001 in the Begin the assignment use the Account Code edit box.

4. Place 2 in the Increment Account Codes by edit box.

5. Click Apply.

The result will be…

BIN 001 = 00001
BIN 002 = 00003
BIN 003 = 00005
…
BIN 010 = 00019

SECTION 4 ASSIGNING CALL APPEARANCE KEYS

The Call Appearance Keys multi-assignment dialog enables you to set up a group of 
function keys as CAP keys for multiple telephones. The dialog can be used to set up 
many telephones to have the same set of CAP keys or unique CAP keys across the 
telephone group.

The dialog is found under the menu item Home > MultiAssign > Call Appearance 
Keys.  

When using the Call Appearance Keys dialog, you should begin by deciding how the 
CAP keys should be setup. The choices are:

1. Same on all phones.

2. Unique CAP number to each key.
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4.1 Assigning the Same CAP Keys on All Telephones

In this mode, the same CAP keys appear on all the selected telephones.   

Figure A-3  MultiAssignment CAP Keys (Same)

3) Click the Setup box.  When the dialog box is displayed,
click Same and click OK.
An informational message is displayed indicating the same
CAP keys will be applied to the selection.

2) Select the function
keys to be set by clicking
in the check boxes.

1) Select the
telephones.

(Optional) Click 
Go to view the 
assignments.

4) Click Apply
to trigger the
assignment.
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To assign a group of telephones: 

1. Select the telephones from the Telephones list by clicking the check
boxes.

2. Select the function keys that you want to assign to the selected
telephones by clicking the Function Key checkboxes.

3. Click the Setup box to display the assignment type dialog box. Click the
Same button and click Specify if using CTI checkbox if appropriate.
Enter the starting CAP key number in the Start the assignment with
CAP field.

4. Click OK. The main CAP key assignment dialog is returned with the
assigned numbers displayed.

If required, edit the actual value for each function key that is displayed in the
Function key checkbox.

5. Click the Apply button to trigger the assignments.

Example

To setup extensions 101 ~105 to have function keys 1~8 set as CAP Keys 
0010~0017 follow the steps below: 

1. Select extensions 101~105 from the telephone list.

2. Click function keys 1~8 (i.e., click all items in the first row of function
keys).

3. Click the Setup box to display the assignment type dialog box.  Click
the Same button, click Specify if using CTI checkbox if appropriate,
enter the starting CAP key number in the Start the assignment with
CAP field.

4. You will see function keys 1~8 given the values 0010 ~ 0017.

5. Click the Apply button to trigger the assignments.

The result is…

NOTE
 If you want to view previous assignments, press the Go button.

NOTE


This example assumes CAP numbers 0010 and onwards are not used and 
CAP number 0010 is the first free call appearance number.

Ext 101 Ext 102 Ext 105

Key 1 = CAP 0010 Key 1 = CAP 0010 Key 1 = CAP 0010

Key 2 = CAP 0011 Key 2 = CAP 0011 … Key 2 = CAP 0011

… … …
Key 8 = CAP 0017 Key 8 = CAP 0017 Key 8 = CAP 0017
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4.2 Assigning Unique CAP Number to Each Key

In this mode, a unique CAP number is assigned to each selected function key 
across all the selected telephones.   

Figure A-4  MultiAssignment CAP Keys (Same)

3) Click the Setup box.  When the dialog box is displayed,
click Unique and click OK.
An informational message is displayed indicating a Unique
CAP key will be applied to the selection.

2) Select the function
keys to be set by clicking
in the check boxes.

1) Select the
telephones.

(Optional)  Click 
Go to view the 
assignments.

4) Click Apply
to trigger the
assignments.
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To assign a group of telephones: 

1. Select the telephones from the Telephones list by clicking the check
boxes.

2. Select the function keys that you want to assign to the selected
telephones by clicking the checkbox.

3. Click the Setup box to display the assignment type dialog box. Click the
Unique button and click Specify if using CTI checkbox if appropriate.
Enter the starting CAP key number in the Start the assignment with
CAP field.

4. Click OK. The main CAP key assignment dialog is returned with the
assigned numbers displayed.

If required, edit the actual value for each function key that is displayed in the
Function key checkbox.

5. Click the Apply button to trigger the assignments.

Example

To setup extensions 101~105 to have unique CAP keys across function keys 1~8 
follow the steps below: 

1. Select extensions 101~105 from the telephone list.

2. Click function keys 1~8 (i.e. click all items in the first row of function
keys).

3. Click the Setup box to display the assignment type dialog box. Click the
Same button, click Specify if using CTI checkbox if appropriate, enter
the starting CAP key number in the Start the assignment with CAP
field.

4. Enter 0010 in the Start with CAP number edit box. Or alternatively
click the “…” button and select CAP 0010 from the selection box.

5. Click the Apply button to trigger the assignments.
The result is…

NOTE
 If you want to view previous assignments, press the Go button.

NOTE


This example assumes CAP numbers 0010 and onwards are not used and 
CAP number 0010 is the first free call appearance number.

Ext 101 Ext 102 Ext 105

Key 1 = CAP 0010 Key 1 = CAP 0018 Key 1 = CAP 0026

Key 2 = CAP 0011 Key 2 = CAP 0019 … Key 2 = CAP 0027

… … …
Key 8 = CAP 0017 Key 8 = CAP 0025 Key 8 = CAP 0033
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SECTION 5 ASSIGNING DIRECT INWARD DIAL (DID) NUMBERS

DID allows you to assign multiple DID table entries.

The dialog is found under the menu item Programming > MultiAssign > Direct 
Inward Dial (DID).

To assign DID entries:

1. Enter the DID Translation Table Entry number to begin the assignment.

2. Specify the number of indials.

3. Enter the starting Received Number.

4. Specify either Extension or Dial number by clicking the associated button.

5. Use the pulldown menu to select the appropriate Target Number.

6. Click the Apply button to trigger the assignments.

Figure A-5  MultiAssign Direct Inward Dialing (DID)

1) Enter the
DID Translation
Table number.

6) Click Apply
to trigger the
assignments.

2) Specify the
number of indials.

3) Enter the starting
Received Number.

5) Select the starting
Target Number.

4) Click either
Extension or Dial
number.
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SECTION 6 ASSIGNING EXTENSION NUMBERS

The Extension Number multi-assignment dialog enables you to set a range of 
extension numbers to ports. This saves valuable time over having to enter each 
extension number individually. In addition, the dialog allows you to set blank 
extensions, thus providing a convenient way of freeing extension numbers for use by 
other ports.

The dialog is found under the menu item Home > MultiAssign > Extension 
Numbers.   

Figure A-6  MultiAssignment Extension Numbers

1) Select
extension type.

2) Specify beginning
and ending port
numbers in the range.

4) Click Apply
to trigger the
assignments.

3) Enter the extension
number used to begin
assignment (or leave
blank to clear numbers).
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To assign a group of ports with extension numbers:

1. Select the type of extensions you want to apply.

2. Specify the port range over which to iterate.

3. Specify the extension number to begin the assignment. (Leave this field blank
to clear the extension numbers).

4. Click the Apply button to trigger the assignment.

Example

To assign telephone ports 001~099 with extension numbers 301~399:

1. To assign station numbers select 11-01: Extension Numbering as our extension
type.

2. Place a 1 in the Begin at Station Port edit box.

3. Place a 99 in the End at Station Port edit box.

4. Place 301 in the Begin the assignment use the extension edit box.

5. Click Apply.

The result is…
Port 001 = Ext 301
Port 002 = 302
Port 003 = 303
…
Port 099 = 399

SECTION 7 ASSIGNING FUNCTION KEYS

The Function Keys multi-assignment dialog enables you to setup a group of function 
keys for individual or multiple telephones. The dialog is best used if you need to set 
up many telephones to have the same set of function keys. The function layout can 
also be saved as a template to use when needed.

NOTE


The extension numbers must validate against the numbering plan setup in 
PRG-11-01. In addition, duplicate extension numbers cannot exist. In this case, 
free the extension numbers by assigning a blank to the ports using those 
extension numbers.
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From the main menu choose Home / Multi-assign / Function key.  

From Easy Edit choose Basic Setup / Extensions / Key Assignment / Function Key 
Template.   

Figure A-7  MultiAssignment Function Keys

Figure A-8  Function Key Template Selection
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Once on the Key Template page the pull down menu will show a list of extensions. 
When “Show all ports” is enabled every extension the system is capable of 
supporting is shown. If disabled, only extensions that are actually installed in the 
system are displayed. The default for this option is enabled.

When “Show all keys” is enabled, function keys 1~48 are shown. If disabled, only 
function keys 1~24 are shown. The default for this option is enabled.   

Figure A-9  List of Extensions
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Once the extension has been selected, click on the Edit Keys tab and assign the 
Function Keys. To assign a key choose the feature to assign to a key, then click on 
the key to be assigned. In cases where additional options must first be selected, a 
menu will be displayed showing the option. The example below shows the options 
when assigning CAP keys.

Here you see that CAP was selected from the function key options, in the Choice box 
CAP Key 3 was selected, then line key three was clicked on. At that point line key 
three is selected and the Choice box automatically advances to CAP Key 4. You can 
continue to click on subsequent function keys until the desired CAP keys have been 
assigned.   

Figure A-10  Assigning CAP Keys
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You can also choose to assign an entire row with CAP keys by right clicking on a 
function key and choosing “Fill a Row”. PC Pro will start on which ever line key you 
select and fill to the end of that row. For this example a default extension will have the 
top row assigned as CAP Keys 1~6 and the second row will be unassigned.   

After selecting a CAP Key, and to start with CAP Key 1, the first line is right clicked. 
Then Fill a Row is selected. 

Figure A-11  Fill a Row Example

Figure A-12  Fill a Row Example
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The first row has now been assigned. Next the “none” option was selected, line key 7 
was right clicked on, and “Fill a Row” was chosen from the displayed options.  

Using the Apply Multiple Tab you can copy the line key settings from the selected 
extension to other extensions. Note the CAP Key multi-assign function is not 
available here, only a straight copy of the line keys exactly as programmed. The CAP 
key multi-assign function is still available from the main menu.  

Figure A-13  Fill a Row Example

Figure A-14  Apply Multiple 
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SECTION 8 SAVING A FUNCTION KEY TEMPLATE

PC Pro allows an extension’s function key configuration to be saved as a template to 
be used later. To save a configuration as a template go to Easy Edit choose Basic 
Setup / Extensions / Key Assignment / Function Key Template. Once there, you can 
choose the extension to be used as the template from the pull down menu. 

Next click on the “Save As” icon, browse to the location on the support PC to store 
the template file, name the file and click Save.  

Figure A-15  Saving a Function Key Template

Figure A-16  Saving a Function Key Template
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SECTION 9 OPENING A SAVED FUNCTION KEY TEMPLATE

PC Pro allows an extension’s function key configuration to be saved as a template to 
be used later. To open a saved configuration template, go to Easy Edit choose Basic 
Setup / Extensions / Key Assignment / Function Key Template. Once there, click on 
the “Open” icon.  

Next browse to the location on the support PC where the template file is stored, 
select the file and click “Open”.  

Figure A-17  Opening a Saved Function Key Template

Figure A-18  Opening a Saved Function Key Template
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Appendix B

UNIVERGE® SV9100

Communications

SECTION 1 OVERVIEW

PCPro provides methods for the application to communicate with the chassis.  
PCPro can connect to the chassis to allow you to download/upload data, to perform a 
system initialization, to update firmware, to activate features and to backup a 
database to or restore a database from a flash key.

SECTION 2 CONNECT/DISCONNECT

Connect/Disconnect makes or breaks a connection session between PCPro and a 
chassis.  This option changes its functionality depending on the connection status of 
PCPro.  Figure B-1 Connect/Disconnect Status shows how the connection status is 
indicated on the toolbar.   

Figure B-1  Connect/Disconnect Status

Disconnected Signifies that PCPro is not connected to the chassis.

Connected Signifies that PCPro is currently connected to the chassis.

Connect/Disconnect Status
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2.1 Accessing Connection Dialog

Connecting PCPro to a system is done within the Connect dialog. While PCPro is 
disconnected from a system, access the Connect dialog using one of the following 
three methods.

 Select the menu item Home:Communications > Connect/Disconnect.

    -- or --

 Select the icon depicting the disconnected black and yellow plugs .

    -- or --

 Press F5.

2.2 Connecting PCPro to the System

Use the Connect dialog box to specify connection parameters to connect to the 
system.

Figure B-2  Connect Dialog

3) (Optional) Load
a defined
Connection
Account (can skip
steps 1~3 by using
this option).

1) Select
Connection Type.

2) To login, specify
the User Name and
Password.

4) To make the
connection to the
system, click
Connect.

 



ISSUE 2.0

SV9100 PC Programming Manual B-3

Figure B-3  IPKII Connect Dialog

3) (Optional) Load
a defined
Connection
Account (can skip
steps 1~3 by using
this option.

1) Select
Connection Type.

If connecting to an 
IPK II system, select 
either Direct or 
Modem Connection 
Type.

2) To login, specify
the User Name and
Password.

4) To make the
connection to the
system, click
Connect.
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To make a connection between PCPro and the system:

1. Select a Connection Type and specify the settings relevant to the
selected type.

2. Specify the User Name and Password used to allow the connection.

3. Alternatively, steps 1~2 can be skipped loading a defined connection
account (refer to  - Connection Accounts).

4. Press the Connect button.

After a successful connection, the connection settings that are used are
set to the File Properties.

2.2.1 Connection Types

PCPro supports four types of connections to a system. Two connection 
types are for SV9100 and three apply only to IPK II. 

Connection Types for SV9100: 

 IP
An IP Connection can be made via a LAN or the Internet. The IP
address specified should match the system setting 10-12-01. If
connecting to the ethernet port on the VoIP daughter board, use the
IP address setting in 10-12-09.

 Dial-up
An IP Connection via Dial-up can be made via a dial-up connection,
either through ISDN or an analog modem.

 Outbound IP
Use this connection type if connecting to the system via a outbound
IP connection. The listen port number should match the value of 90-
69-01 on the system. And the IP address of the PC should match the
value of 90-62-02.

Connection Types for IPK II only: 

 LAN
An IP Connection can be made via the LAN.  The IP address
specified should match the system setting 10-12-01.

TIP

❍ If connecting to an SV9100 system, select either IP or IP via
Dial-up or Outbound IP.

❍ If connecting to an IPK II system, select either LAN, Direct or
Modem.

NOTE


To install dial up connection, refer to paragraph 2.2.2 Create 
SV9100 Dial Up Connection on page B-5.
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 Direct
A Direct Connection can be made via an available serial port on a PC.
Specify the PCs serial port and its transfer rate (bps). This speed
must match the KSU baud rate setting assigned in 10-21-02.

 Modem
A Modem Connection can be made from an existing modem
connected to the PC. Specify the modem number to dial.

2.2.2 Create SV9100 Dial Up Connection

When connecting an SV9100 via modem, a Dial Up Connection (PPP) must 
be created. The following steps describe how to set up the Dial Up 
Connection (PPP).

1. Click Start >Settings>Network Connections.

2. Select Setup a New Connection or Network.

NOTE


❍ To access the modem over K-CCIS, route the modem
access service code to the target switch.  Do not call a
station that is call forwarded to the service code. When
accessing the modem over K-CCIS, enter the service code
to be dialed in PCPro.

❍ Note that PCPro follows the PCs dialing properties. If
dialing a service code, you must turn off the dial 9 for
outside line and area code inclusion or PCPro will dial
these digits as well.

Figure B-4  New Connection Wizard Dialog
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3. Click Next.

4. Select Connect to a workplace, then click Next.

Figure B-5  Network Connection Type Dialog
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5. Select Dial directly.

6. Enter the destination phone number, the name to be used for
the dial-up connection and check the box next to "Allow other
people to use this connection" then click Next.

Figure B-6  Network Connection Dialog

Figure B-7  Connection Name Dialog
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7. Enter the login name (tech) and the password to be used
(12345678) and check the box next to "Remember this
password", then click Connect.

IMPORTANT

Ensure the SV9100 programs 11-15-14, 22-02 and 22-07 
are setup to receive calls to the modem.

Figure B-8  Phone Number to Dial Dialog
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8. The PC will then try to dial the destination. Since this will be
used later click Skip to stop the dial out.

9. Click Close.

Figure B-9  Connection Availability Dialog

Figure B-10  Completing the New Connection Dialog
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10. The Connection will now appear in the network connection
screen and can be used by PC Programming when needed.

2.2.3 Login

Specify the User Name and Password that will allow the connection. The 
account must exist within the chassis settings 90-02. Like PCPro Accounts, 
Login Accounts govern what system data can be accessed from the 
chassis.

It is important to note, Login Accounts are not the same as PCPro 
Accounts. Thus both chassis Login and PCPro Account settings are NOT 
synchronized and are independent of each other.

Once connected, the PCPro access level changes to match the level 
assigned to the user name/password used to connect. This access level is 
set in 90-02 on the chassis. For example, if you start PCPro in Installer (IN) 
mode, but connect to a chassis using an account with an access level of 
System Administrator Level 1 (SA), after connecting PCPro assumes the 
access level of SA. Once you are disconnected, PCPro reverts back to the 
access level IN.

Figure B-11  Connect SV9100 Dial Up Connection
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2.3 Disconnecting PCPro from the System

While PCPro is connected to a system, you can disconnect using one of the 
following methods:

1. Select the menu item Home:Communication > Connect/Disconnect.

    or…

2. Select the icon depicting the connected black and yellow plugs .

or…

3. Press F5.

All communication methods, excluding ‘Connect/Disconnect’, are disabled and 
the ‘Connect/Disconnect’ toolbar icon changes status to disconnected.

SECTION 3 DOWNLOAD

Downloading pulls all the data off the system and loads it into PCPro. A download 
can only occur when PCPro is connected to a system.

3.1 Accessing Download

When PCPro is connected to a system, access the Download dialog using one of 
the following methods.

 Select the menu item Home:Communication > Download.

    -- or --

 Select the icon depicting the blue arrow .

  -- or --

 Press F6.
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3.2 Downloading Data from the System to PCPro

Use the Download dialog to specify the parameters and perform a download. 

To download data from system memory to PCPro:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the download is completed, press the Close button.

Figure B-12  Download Dialog

3) Apply filter
to help find
items.

1) Select
Transfer Type.

2) Select
additional
item(s) to
download.

4) Click Start to begin
download.

5) When completed, click
Close.
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3.2.1 Transfer Type

Select a filter that controls the scope of settings to download. The following 
Transfer Types are made available.

 All: No filter, all chassis settings.

 Blade Configuration: Blade package settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based
settings.

 System Data Partial (Trunk): Trunk-based settings.

Transfer Type Items

Specifically select PRG Groups and/or individual PRGs from the chassis 
settings to download. The choice of Transfer Type Items available is 
governed by the Transfer Type selected.

Modify Filters

A  filter is applied based on the system data modification status. The filter 
only applies to system data on the PCPro side, not system data residing in 
chassis memory. Refer to  - Modification History for further information.

SECTION 4 UPLOAD

Uploading pushes all the data from PCPro to system memory. An upload can only 
occur when PCPro is connected to a system.

4.1 Accessing Upload

When PCPro is connected to a system, access the Upload dialog using one of the 
following methods:

 Select the menu item Home:Communication > Upload.

    -- or --

 Select the icon depicting the red arrow .

  -- or --

 Press F7.
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4.2 Uploading Data from PCPro to System Memory

Use the Upload dialog to specify the parameters and perform an upload. 

To upload data from PCPro to system memory:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the upload is completed, press the Close button.

Figure B-13  Upload Dialog

3) Apply filter
to help find
items.

1) Select
Transfer Type.

2) Select
additional
item(s) to
upload.

4) Click Start to begin
download.

5) When completed, click
Close.
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4.2.1 Transfer Type

Select a filter that controls the scope of chassis settings to upload. The 
following Transfer Types are made available.

 All: No filter, all Chassis settings.

 Blade Configuration: Blade packages settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based
settings.

 System Data Partial (Trunk): Trunk-based settings.

Transfer Type Items
Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to upload. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters
A filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory. Refer to  - Modification History for 
further information.

4.3 Uploading Blade Configuration 

When uploading the Blade Configuration via Upload All, and selecting Card 
Configuration, or just Uploading Card Configuration, a warning popup will 
display when either Trunks or stations are busy at the time of selecting to 
uploading the Card Configuration.  This will allow for the upload to be canceled 
and completed at a later time, or to be continued and will disconnect the busy 
trunks and/or stations. 
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This popup is shown when the Card Configuration is selected to be uploaded and 
the trunks are busy. 

This is popup is shown when the Card Configuration is selected to be uploaded 
and stations are busy.  

SECTION 5 FEATURE ACTIVATION

Some system features are licensed and require registration before they can be used.  
Features can be activated by registering the feature automatically via the Internet or 
manually by downloading the associated Software Code.  Feature Activation can 
only occur when PCPro is connected to a system.  

5.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog by 
selecting the menu item Home > Maintenance > Feature Activation.

Figure B-14  Trunk Ports Busy Warning

Figure B-15  Station Ports Busy Warning
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5.2 Activating a Feature
Refer to  - Feature Activation for a detailed discussion.

Figure B-16  Feature Activation Dialog
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SECTION 6 FIRMWARE UPDATE

Firmware Update automatically updates the main software in a system remotely at a 
scheduled time. This feature saves times and effort in comparison to performing the 
task manually. A Firmware Update can only occur when PCPro is connected to a 
chassis.    

The time to upload the firmware package file is directly related to the file size. 
At present, the package file is about 21MB, so over LAN it may take several 
minutes.

A backup of system data should be performed before any firmware update.

Figure B-17  Firmware Update Dialog
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Before Firmware Update can be used the system must meet the following 
requirements:

1. Feature Activation
The Firmware Update feature must be registered through Feature
Activation. Refer to Section 5 Feature Activation on page B-16 for
details.

2. Hardware
The hardware prerequisite for Firmware Update is the USB drive. The
USB drive is used to store the Firmware Update file before the operation
is executed.

6.1 Accessing Firmware Update

When PCPro is connected to a chassis, access the Firmware Update dialog by 
selecting the menu item Home > Maintenance > Upgrade SW.

6.2 Using Firmware Update

Use the Firmware dialog to specify the parameters and perform a Firmware 
Update.

To perform a firmware update:

1. Select a Firmware File.

Firmware Package File:
Select a Firmware package file provided by NEC. Updating a chassis with a faulty
Firmware page file could render the system unusable.

2. Schedule when the Firmware Update is to occur using the parameters in
the Schedule Update section.

Schedule:
Schedule when the Firmware update will occur. The changes of the
Firmware Update will only occur after the chassis is reset. Thus the
Firmware Update should be executed at a suitable time when the
chassis is not actively in use.

3. Press the Start button.

NOTE


The time you specify should be relative to the time on the chassis, not 
the local time of the PC.
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6.3 Firmware Update via Web Pro

WebPro supports Remote System Upgrade. Available features or procedures are 
the same as PCPro Remote Upgrade.  

1. Click the ‘Firmware Update’ icon and the following pop up screen is
displayed.

2. In the Firmware Update screen, select a location of the Firmware
Package file. For example, the file name might be:
SV9100_v1.0RemoteUpgrade.mdu

3. Select the schedule type:

 Immediately after upload

Figure B-18  Firmware Update Icon

Figure B-19  Firmware Update Screen
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 At the time...

 If you choose ‘At the time...’ select the date and time you want the 
GCD-CP10 to reset and switch over to the new software version.

4. Click the ‘Start Update’ button. WebPro uploads the firmware package
file, and updates the system at the time you specified in step 3.

SECTION 7 CONDITIONS

WebPro supports Remote System Upgrade. WebPro upgrade requires”

 Firmware package file from NEC

 User level (PRG90-02-03) has to be 2 = IN (Installer Level) or higher.

 CAUTION

DO NOT click the Home or Back buttons on the browser, or close the WebPro 
browser, during uploading the Firmware, otherwise Upload stops.
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SECTION 8 SYSTEM INITIALIZATION

A System Initialization resets a system. During an initialization all telephone calls are 
dropped and all connections to WebPro, PCPro and the handset are lost.  Therefore, 
it is important that initialization should be executed at a suitable time when the 
system is not actively in use. PCPro can only execute an initialization when it is 
connected to a system.    

When PCPro is connected to a system, access the System Initialization dialog by 
selecting the menu item Tools > System Initialization.

8.1 System Initialization Type

Within the System Initialization Dialog, access the initialization process.

2nd Initialization
A 2nd Initialization resets the chassis and retains all previously modified values 
within system data.

Figure B-20  2nd Initialization Selected
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Copy

SECTION 1 OVERVIEW

The system data copy function allows you to copy data from one item to another 
(e.g., one trunk to another).  This copy only applies to a single program. Copy only 
appears on screens where it is applicable.    

Figure C-1  System Data Copy

2) Specify copy source.

3) Specify copy
destination.

4) Specify data to be
copied.

5) Click OK to copy.

1) Select copy.
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SECTION 2 COPYING SYSTEM DATA

To copy a system data item: 

1. Press the Copy button .

2. When the Copy dialog box is displayed, specify the source to copy from.

The source (From) shows the item being copied from. Only a single source
item can be selected.

3. Specify elements of the source that you want to copy.

These settings are specific to the system data being copied.

4. Specify the destination where you want to the elements copied.

The destination (To) details the item(s) where the selected source information
is copied to. Multiple destination items can be selected.

5. Press OK to copy the selected items.
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Modification History

SECTION 1 OVERVIEW

PCPro keeps a record of all the modifications made to a database file. This record is 
known as the Modification History. PCPro also provides you with the ability to view 
this history list. Following is the list of database operations that PCPro records in the 
modification history.   

The modification history is only saved in the local database when you perform File 
Save or File Save As. The modification history is a running list of the changes. 
PCPro keeps appending to the list. If you open a file, make changes, save and close 
the file and in the future open the same file and make additional changes, then the 
new modification history is appended to the old.

Operation Details

System Data Set This includes programming performed through:
 Standard View Screens

 System Data Programming

 Copy
For each set, an entry is made to the history list. The entry records the 
following items:   

Field Data

Date Date and time of operation.

User Name The User Name that performed the operation.

Display Name
The Display Name that performed the 
operation.

Access Level
The Access Level that performed the 
operation.

Type 
Identifies the operation type.  Set to “Set 
Date”.

Modification The system data ID.

Details
The item changed.
Old value.
New value.
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The modification state of a PCPro database is indicated via the modification icon on 
the Status Bar. The different filters are:    

SECTION 2 ACCESSING MODIFICATION HISTORY

To access Modification History, complete one of the following:

 Select the menu item Reports > Modification History.

-- or --

 Select the clock icon on the toolbar .

SECTION 3 GENERATING A MODIFICATION HISTORY REPORT

A Modification History Report can be viewed in either HTML format or Comma 
Separated Variable (CSV) format. Sample formats are shown in Figure D-2 Sample 
Modification History HTML Format on page D-3 and Figure D-3 Sample Modification 
History CSV Format on page D-4. 

To request a report:

1. Access the report by selecting Modification History from the toolbar or by
clicking the clock icon (refer to Section 2 Accessing Modification History).

2. When the Export Modification History dialog box is displayed, click either the
HTML or CSV option and press OK.

The database is not modified. All data has been saved to file and uploaded.

System data has been modified and has not been saved to file.

System data has been saved to file but has not been uploaded.

System data has been modified and has not been saved to file nor uploaded.
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3. The report is generated in the format you selected.  (Refer to Figure D-2
Sample Modification History HTML Format and Figure D-3 Sample Modification
History CSV Format on page D-4).

Figure D-1  Export Modification History Dialog Box

Figure D-2  Sample Modification History HTML Format
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Figure D-3  Sample Modification History CSV Format
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Connection Accounts

SECTION 1 OVERVIEW

Connection Accounts provide a convenient way of loading user defined connection 
settings. These are application wide settings.  Connection Accounts can be created 
in two ways:

 Via the Connect dialog

 Via the Connection Accounts dialog

SECTION 2 CREATING/DELETING A CONNECTION ACCOUNT USING THE 
CONNECT DIALOG

This section describes how to use the Connect dialog to create a new Connection 
Account or delete an existing Connection Account. (Refer to Figure E-1 Connect 
DialogCreating/Deleting Connection Account on page E-2.)
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2.1 Creating a New Account

To create an account using Connect dialog:

1. Select a Connection Type and specify settings relevant to the
Connection Type.

2. Specify the Login User Name and Password used to allow the
connection.

3. Press the Save or Save As button located in the Connection Account
section of the dialog.

4. When the Save As dialog is displayed, enter a description of the
connection (refer to Figure E-2 Save As Connection Account Dialog on
page E-3.)

Figure E-1  Connect DialogCreating/Deleting Connection Account

Click Save or Save As to 
create a Connection 
Account.

Select the 
Connection Type. 

Specify the Login User 
Name and Password.

Select a Connection 
Account from the 
pulldown menu and click 
Delete a Connection 
Account.
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5. Press OK to save the Connection Account.

2.2 Deleting an Account

An existing Connection Account can be deleted.  

To delete an existing account:

1. Select the Connection Account from the pulldown menu on the
Connect dialog. (Refer to Figure E-1 Connect DialogCreating/Deleting
Connection Account on page E-2.)

2. Click the Delete button.

Figure E-2  Save As Connection Account Dialog

Enter the Connection 
Account description.

Click OK to save the 
Connection Account.
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Debug Terminal 

SECTION 1 OVERVIEW

PCPro provides a debug terminal that can be used to capture trace logs from the 
GCD-CP10 in the chassis. The debug terminal communicates with the chassis via 
the LAN. A TCP connection on port 5963 is established between the debug terminal 
and the chassis. This port number is blank by default now. It needs to be set under 
10-20-06 and also DIM Access needs to be enabled under 90-31

Figure F-1  Debug Terminal Dialogs

1) Specify
connection
information.

2) Specify the
log file to be
used for data
capture.
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SECTION 2 LAUNCHING THE DEBUG TERMINAL

You can launch the debug terminal in one of two ways:

 Select the menu item Tools > System > DbgTerm.

    -- or --

 Click on the DbgTerm icon on the toolbar  .

If PCPro is connected via LAN to a chassis, then the debug terminal automatically 
tries to connect to the same IP address (domain name). Once the debug terminal is 
running, incoming debug messages from the chassis appear on the screen. You can 
capture the incoming data to a file by specifying a log file name and enabling the log 
capture.

Log capture can be enabled or disabled at the your discretion. A message is printed 
in the log file indicating the date and time the capture was enabled or disabled.
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Feature Activation

SECTION 1 INTRODUCTION

There are three methods for activation of features on the GCD-CP10: automatic 
activation via PCPro, manual activation via PCPro and manual activation via 
WebPro. 

SECTION 2 FEATURE ACTIVATION USING PCPRO

Some system features require registration before they can be used. Feature 
Activation registers these manually through input of Activation Codes. Feature 
Activation can only occur when PCPro is connected to a system.   

Figure G-1  PCPro Feature Activation Dialog

Hardware Key (number assigned 
by NEC and printed on equipment).

Informational area that lists features available for activation.  For each feature, 
the quantity registered, the activation status (On = activated, Off = not activated) and 

an expiration date for feature activation (if assigned) is displayed.

Manual  
Registration

Request html report 
for license.

Exit Feature 
Activation.
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2.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Home > Maintenance > Feature Activation.

2.2 Manually Activating a Feature

Manual Activation does not require that you have an Internet connection.  
However, you must have previously downloaded the license file that was 
generated by the NEC Product License Server.   The license file contains the 
Software Code, which is required to activate the feature.

To activate a feature manually:

1. Launch PCPro and access Feature Activation (refer to 2.1 Accessing
Feature Activation).

2. If connected to the SV9100 system, the Hardware Code is retrieved and
displayed.

3. Click Load File (refer to Figure G-2 Feature Activation Open File Dialog
on page G-3).

 CAUTION

This file can reside on the PC or you can copy it to a flash drive to 
reference if activating other locations.
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4. When you have located the file (xxxxxxx.lic), select it and click Open.

5. When the confirmation dialog is returned, click Save & upload now to
immediately save the file on the ProPro database and activate the
feature.

Figure G-2  Feature Activation Open File Dialog
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SECTION 3 FEATURE ACTIVATION USING WEBPRO

WebPro can also be used to manually activate features.

3.1 Manually Activating a Feature

To activate a feature using WebPro, you must have Internet connection.

1. Point your browser at the IP address of the GCD-CP10 (set in PGM
10-12-01).

2. When the Home page is displayed, enter the User Name and
Password.

The default User Name = tech and Password = 12345678.

Figure G-3  WebPro Login Screen
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3. If login was successful, the WebPro Home page is displayed.  Click
Feature Activation.  

Figure G-4  Feature Activation Screen WebPro Home Page
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4. The WebPro License Registration dialog is displayed.

5. If connected to the SV9100 system, the Hardware Code is retrieved and
displayed.

6. In the Upload a license file to the KTS field, click Browse to locate the
license file (XXXXXXX.lic).

7. When the Open dialog is displayed, select the license file and click
Open.  When prompted to proceed, click Yes.

Figure G-5  Feature Activation Screen WebPro Manual Activation

 CAUTION

The license file is obtained by accessing the NEC Product Activation 
Server, or by activating the feature using PCPro (refer to Section 3 
Feature Activation Using WebPro on page G-4).

TIP

This file can reside on the PC or you can copy it to a flash drive to 
reference if activating other locations.
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8. Click Upload to retrieve the license file.

9. If the license file upload is successful, the feature is activated.

Figure G-6  Feature Activation Open File Dialog WebPro
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3.2 Recovery License

Recovery License allows you to license all the features for 30 days.  Please 
refer to the SV9100 Features and Specifications Manual for more 
information. 

To Activate the Recovery License:

1. Go to https://eip.necunified.com/login.aspx

2. Input the User Name and Password.

3. Go to the Recovery License section.

Figure G-7  NEC Information Portal Login Screen
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4. Select the Company and Site location.

5. Generate Recovery License.

3.3 Further Information

For further information on Feature Activation visit:

https://eip.necunified.com/login.aspx

Figure G-8  Recovery License Access Screen

NOTE
 You can only have two for each site.
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Database File Conversion

SECTION 1 OVERVIEW

This feature converts an SV8100 PCPro database file into a SV9100 PCPro 
database file.

SECTION 2 OPERATION

Use the following procedure to perform SV8100 PCPro configuration file (*.pcp) to 
SV9100 PCPro configuration file (*.pcpx). 

2.1 SV9100PCPro

1. Select [File] -> [Open], the file open dialog appears, then select file(*.pcp) to
execute system data conversion.

Figure H-1  Selecting File
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2. Please select PCPro database file to convert. (Extension is available with
“*.pcp”,”*.pcpx”.)
>Select the file and click Open.

3. After open the file to convert, the following confirmation dialog will appear. Click
OK to convert the file into SV9100 database file.

Figure H-2  Database File Conversion Selection

Figure H-3  DIM File Download Status
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4. Conversion process is now completed.

Figure H-4  Complete File Conversion
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DIM File Download

SECTION 1 OVERVIEW

The DIM File Download feature supports downloading a DIM log file using PCPro. A 
DIM log file contains operational, system information, and critical information about 
the system.

With Version 2.xx.xx system software the DIM files can be downloaded to a USB 
drive mounted to the CPU. Use program 90-03-02, after mounting a USB drive to the 
CPU, enter 1 and press Transfer to copy.

SECTION 2 OPERATION

Use the following procedure to download a DIM log file using PCPro.

1. From the PCPro toolbar, select Tools > System > DIM File Download.  A DIM
File Download dialog box appears, Figure I-1 - DIM File Download.

NOTE


The DIM File Download menu is only available when PCPro is connected to 
the system.

Figure I-1  DIM File Download
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2. Check the Download box next to the file(s) to download from the system.

3. Click OK.  PCPro begins downloading the selected file(s) from the system.  A
status line on the bottom indicates which file is being downloaded at that
moment.  Refer to Figure I-3 - DIM File Download Status.

NOTE


When the Download Dialogue runs, PCPro requests file information from 
"C:\\DATA\\*.txt"".  The Dialog Box displays all existing files with  
"C:\\DATA\\*.txt"".  

Figure I-2  DIM File Download Dialog Box
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Figure I-3  DIM File Download Status

 CAUTION

Limitation: 
The maximum file size that it is available to download with PCPro is 1MB 
per file.  

If the file is 1.5MB, the first 1MB will download, but the last 500 KB will 
not download.
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Maintenance Features

SECTION 1 OVERVIEW

The following four features are supported:

 SRAM Information via Web / PC Pro.

 System Alarm display via Web Pro.

 T1/ISDN layer status display via Web / PC Pro.

 USB Backup via Web Pro.

SECTION 2 OPERATION

2.1 SRAM Information via Web Pro/PCPro

The following data is saved in internal SRAM and can be checked via Web/PC 
Pro. These are listed in PRG 93-xx. These programs are Read-Only, and cannot 
be accessed via User Pro.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

3 = SA (System Administrator Level 1)   

Table J-1  Program Table 

Program No. Name Input Data (Read Only)

93-01-01 Day/Night Mode
Indicates current day/night mode 
per night mode service group.

1 = Mode 1
2 = Mode 2
3 = Mode 3
4 = Mode 4
5 = Mode 5
6 = Mode 6
7 = Mode 7
8 = Mode 8
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93-02-01 Automatic Transfer to Transfer
Indicates Automatic Trunk 
Transfer setting status.

0 = Disable
1 = Enable

93-02-02 Trunk Port Disable by Service 
Code
Indicates the Trunk Port Disable 
(Busy Out) status.

0 = Disable
1 = Enable

93-03-01 Call Forward - All/No Answer/Both 
Ring
Indicates Call Forward -All/No 
Answer/Both Ring setting status 
per extension.

0: = Call Forwarding off
1 = Call Forwarding with Both Ringing
2 = Call Forwarding when No Answer
3 = Call Forwarding All Call

93-03-02 Call Forwarding Destination for 
Both Ring, All Call, No Answer
Indicates Call Forward-All/No 
Answer/BothRing destination 
number set per extension

0-9, *, #, P, R,@
(Up to 24 digits)

93-03-03 Call Forward-Busy
Indicates Call Forward-Busy 
setting status per extension.

0:Call Forward-Off
1:Call Forward-Busy or No Answer
2:Call Forward-Busy

93-03-04 Call Forwarding Busy Destination.
Indicates Call Forward-Busy 
destination number set per 
extension.

0-9, *, #, P, R,@
(Up to 24 digits)

93-03-05 Call Forwarding – Follow-Me
Indicates Call Forward-Follow-Me 
setting status per extension.

Extension Number
(Up to 8 digits)

93-03-06 Call Forwarding Follow-Me 
Destination.
Indicates Call forwarding follow-
me extension number set per 
extension.

0 = Disable
1 = Enable

93-03-07 Do Not Disturb
Indicates DND setting status per 
extension.

0 = No setting
1 = DND External
2 = DND Intercom
3 = DND Transfer
4 = DND All

93-03-08 Message Waiting (Set)
Indicates extension number which 
you set Message Waiting.

Extension Number (Up to
8 digits)

93-03-09 Message Waiting (Receive)
Indicates extension number when 
left Message Waiting

Extension Number (Up to 8 digits)

Table J-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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93-03-10 Alarm Clock 1
Indicates Alarm Clock 1 setting 
status.

0 = Disable
1 = Enable

93-03-11 Preset time at Alarm 1
Indicates the time set in Alarm 
Clock 1.

Time set in Alarm Clock 1.
When PRG 93-03-10 is "0", [00:00] is 
indicated.

93-03-12 Alarm Clock 2
Read only. Indicates Alarm Clock 
2 setting status.

0 = Disable
1 = Enable

93-03-13 Preset Time at Alarm 2
Indicates the time set in Alarm 
Clock 2.

Time set in Alarm Clock 2.
When PRG 93-03-12 is "0", [00:00] is 
indicated.

93-03-14 Forced Intercom Ring (ICM Call 
Type)
Indicates ICM Call Type per 
extension.

0 = Disable (Voice)
1 = Enable (Signal)

93-03-15 BGM
Indicates BGM setting status per 
extension.

0 = Disable
1 = Enable

93-03-16 Key Touch Tone
Indicates Key Touch Tone setting 
status per extension.

0 = Disable
1 = Enable

93-03-17 Dial Block
Indicates Dial Block setting status 
per extension.

0 = Disable
1 = Enable

93-03-18 Repeat Dial
Indicates Repeat Dial setting 
status per extension.

0 = Disable
1 = Enable

93-03-19 Headset Mode Switching
Indicates Headset Mode 
Switching setting status per 
extension.

0 = Disable
1 = Enable

93-03-20 Headset Ringing Mode Switching
Indicates Headset Ringing Mode 
Switching setting status per 
extension

0 = Disable
1 = Enable

93-04-01 Redial Data
Indicates the number stored in 
Outgoing call history.

Dial Data : 1~9, 0, *, #, P,R,@
(Up to 24 digits)

93-04-02 Name
Indicates the name stored in 
Outgoing call history.

Up to 12 characters

Table J-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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93-05-01 Set Automatic transfer at 
Department Group Call
Indicates Automatic transfer 
setting status per Department 
Group.

0 = Disable
1 = Enable

93-05-02 Set Delayed Transfer at
Department Group Call
Indicates Delayed transfer setting 
status per Department Group.

0 = Disable
1 = Enable

93-05-03 Set Delayed Transfer at 
Department Group Call
Indicates Delayed transfer setting 
status per Department Group.

0 = Disable
1 = Enable

93-06-01 IP Address of the 1st Party CTI 
Client
Indicates the IP Address of the 1st 
Party CTI Client.

IP Address:
xxx.xxx.xxx.xxx

93-06-02 Availability of 1st Party CTI 
Connection
Indicates availability of the 1st 
Party Client connection.

0 = Not available
1 = Available

Table J-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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Figure J-1  Example of Program 93-01

Figure J-1  Example of Program 93-02
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Figure J-1  Example of Program 93-03

Figure J-1  Example of Program 93-04

 



ISSUE 2.0

SV9100 PC Programming Manual J-7

Figure J-1  Example of Program 93-05
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2.2 System Alarm display via WebPro

The system alarm can be checked via WebPro. By clicking the System Alarm icon 
at the home screen of WebPro, up to 100 alarm reports can be monitored. 
WebPro does not support an alarm report output. 

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

Figure J-2  Example of WebPro Home Screen
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2.3 T1/ISDN Layer Status Display via WebPro

WebPro can monitor T1 / ISDN link status saved in PRG90-60 (T1/ISDN Layer 
Status Information).

This program displays layer status information for T1/PRI/BRI packages.

- =No link

0 = Link

N/A = except  BRI or PRI card is mounted.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

Figure J-3  System Alarm Screen
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2.4  USB Backup via WebPro

USB backup can save the SRAM data or programmed data to a USB drive using 
WebPro. An alarm report can be also saved together at the time of USB saving 
execution.

System data can also be uploaded from the USB drive to the CPU card using 
WebPro.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

3 = SA (System Administrator Level 1)

Figure J-4  90-60: T1/ISDN Layer Status Information
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Operation:

1. The following home screen is displayed. Click on the “Save to USB
Flash” icon.

Figure J-5  Save to USB Flash
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2. The USB Save screen is displayed. Click the “Start Save” button.

 CAUTION

If the USB drive is not installed in the CPU, an error is displayed.

Figure J-6  Start Save Screen
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3. The following popup window is displayed. Click the “OK” button.

4. The following screen is displayed, and data is saved to the USB Flash
Drive.

Figure J-7  Proceed with Saving Data Screen

Figure J-8  Saving to USB Flash Drive
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5. The following screen is displayed when data saving is completed.

  Conditions:

 To perform a USB save, 32 MB of availability is required for a USB
flash device.

 When moving to Save/Load screen, an error message will be shown
if USB device is not connected.

 After USB backup starts, it cannot be interrupted.

 After USB load finishes, a system reset is needed to activate the
loaded data.

Figure J-9  Save Finished Screen
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Web Pro Load/Save to PC Feature

SECTION 1 OVERVIEW

WebPro supports Load/Save feature of the PCPro database (configuration) file and 
Remote System Upgrade.

SECTION 2 OPERATION

2.1 WebPro Load/Save PCPro Configuration File

‘Load from PC (=Upload)’ and ‘Save to PC (=Download)’ icons are added on the 
Administration area of the WebPro Home Page screen.  

Figure K-1  WebPro Home Page Screen
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2.2 Load from PC

1. Click the ‘Load from PC’ icon, and the following pop up screen is
displayed.

2. Select the PCPro configuration file. The configuration file has to be
decompressed by gzip format (.gz) before upload.

3. Click the ‘Load’ button that starts the configuration file upload.

4. After uploading is completed, ‘Load completed’ is displayed and the
system reboots automatically.

Figure K-2  Load from PC Screen
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2.3 Save to PC

1. Click the ‘Save to PC’ icon and the following pop up screen is displayed.

2. Click the ‘Save’ button that starts decompressed configuration file
download.

3. When saving is completed, ‘Save completed’ is displayed.

Figure K-3  Save to PC Screen

Figure K-4  Save Completed Screen
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4. Then click save (S) and enter the location of the local PC folder to save.

SECTION 3 CONDITIONS

 The configuration file has to be decompressed by gzip format (.gz) before upload.

 User level (PRG90-02-03) has to be 3 = SA (System Administrator Level 1) or 
higher.

 During loading or saving the configuration file, no other user can log in the system 
through PCPro, WebPro, or Phone Programming. On the other hand when 
someone is logging in the system, this feature does not work.   

 CAUTION

After completing the upload, the system reboots automatically, even trunk 
lines and extensions that are on call. So WebPro Upload should be 
performed when the system is not in use.
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Appendix L

UNIVERGE® SV9100

Store Statistical Information of RTP

SECTION 1 OVERVIEW

With Version 3000 or higher CPU software the Store Statistical Information of RTP 
feature supports downloading a RTP log file using PCPro, or to USB via TEL Pro. A 
RTP log file contains operational, system information, and critical information about 
RTP.

SECTION 2 OPERATION

Use the following procedure to download a DIM log file using PCPro

1. From the PCPro toolbar, select Tools > System > RTP Information. A RTP File
Download dialog box appears. Refer to Figure L-1 RTP File Download.

NOTE


The RTP File Download menu is only available when PCPro is connected to 
the system.

Figure L-1  RTP File Download
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2. Check the Download box next to the file(s) to download from the system.

3. Click OK. PCPro begins downloading the selected file(s) from the system. A
status line on the bottom indicates which file is being downloaded at that
moment. Refer to Figure L-3 RTP File Download Dialog Box (showing status).

NOTE


When the Download Dialogue runs, PCPro requests file information from 
“C:\\DATA\\*.csv””. The Dialog Box displays all existing files with 
“C:\\DATA\\*.csv””.

Figure L-2  RTP File Download Dialog Box

Figure L-3  RTP File Download Dialog Box (showing status)

Status Bar:
Indicates which file is 
downloading.
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Use the following procedure to download an RTP log file to USB using TEL Pro.

1. Insert USB Drive into GCD-CP10.

2. Enter Telephone Programming and go to PRG 90-03-03.

3. Enter 1 and Transfer.

4. The log is finished saving after “Saving RTP log” is cleared from display.

SECTION 3 DATA FIELDS

GUIDE TO FEATURE PROGRAMMING

Table L-1  Data Fields

Data Name Data Outline

Start Date The date when the call has started

End Date The date when the call has ended

Ext/TRK Number

Ext/TRK Number (Call Partner)

Cumulative Cnt Receiving RTP packet loss total

Max Fraction Lost When the max packet loss rate and the average 
packet loss rate are the same value, the pocket 
loss is occurring constantly. When the max 
packet loss rate is high compared with the 
average packet loss, it is regarded as a 
temporary packet loss.

Average Fraction Lost When exceeding 1%, reconsideration of the 
network environment is needed.

Number of Sent RTP packets Number of Sent RTP packets

Number of Received RTP packets Number of Received RTP packets

Cumulative Cnt (Remote) Receiving RTP packet loss total of Remote side 
(IP Terminal, IP Trunk, etc.).

Max Fraction Lost (Remote) The max packet loss rate of the remote side.

Max Round Trip Time (Remote) The maximum round trip time of a packet.

Number of Sent RTP packets (remote) The number of Sent RTP packets (remote)

Sender Statistical Information on System Side

Sent Sender Report Ntp Timestamp Sent Sender Report Ntp Timestamp
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Sender SSRC DSP of VOIPDB determines SSRC at random at 
the time of channel opening.

Receiver Statistical Information on System Side

Max Inter Arrival Jitter The max interval of the arrival time of an RTP 
packet.

Average Inter Arrival Jitter The average interval of the arrival time for an 
RTP packet.

Remote Sender SSRC DSP of VOIPDB determines SSRC at random at 
the time of channel opening.

Receiver Information of Remote Side

Average Round Trip Time Average round trip time

Sender Statistical Information on Remote Side

Sent Sender Report Ntp Timestamp Sent Sender Report Ntp Timestamp

Sender SSRC DSP of VOIPDB determines SSRC at random at 
the time of channel opening.

Receiver Statistical Information on Remote Side

Max Inter Arrival Jitter The max interval of the arrival time of an RTP 
packet.

Average Fraction Lost When exceeding 1%, reconsideration of the 
network environment is needed.

Average Inter Arrival Jitter The average interval of the arrival time of an 
RTP packet.

Remote Sender SSRC DSP of VOIPDB determines SSRC at random at 
the time of channel opening.

Optional Information 

Type 0: ICM MLT/STD SIP
1: TRK SIP/H323
4: NET NETLINK
5: CCIS CCIS (IP)
6: ASP Aspire Net (IP)

Src systemID Source System ID

Src port Source Logical Port

Des systemID Destination System ID

Des port Destination Logical Port

Table L-1  Data Fields

Data Name Data Outline
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SECTION 4 GUIDE TO FEATURE PROGRAMMING

This guide provides a list of associated Programs that support this feature.  

SECTION 5 RTP LOG INFORMATION

1. Stations

Program/
Item No.

Description/
Selection

Assigned Data Default Level

11-10-54 Service Code Setup (for 

System Administrator) – 

Save Store Statistical 

Information of RTP
RTP Information is saved on 
SD Card. Although saved every 
1000 calls, it is saved instantly 
with input of this service code.

(Up to 8 digits) 671 1

20-07-35 Class of Service Options 

(Administrator Level) – 

Save Statistical Information 

of RTP
Enable this option to give ability 
to enter service code 671 to 
save Statistical Information to 
SD Card.

0 = Disable

1 = Enable

(COS 1~15)

COS 1~14 = 0

COS 15 = 1

1

90-03-03 Save Statistical Information 

of RTP 
Used to Save Statistical 
Information of RTP to USB 
Flash Drive.

1  Transfer

Table L-2  Stations

Terminal Type Applied/Not 
Applied System *1

Applied/Not Applied 
System *2 Remarks

DT300 Series No No

DT400 Series No No

DT700 Series Yes No

DT800 Series Yes No

Bluetooth Handset No No

SLT No No
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*1 - Statistical RTP Information is available if call uses VoIPDB.

*2 - Statistical RTP Information is available if terminal supports RTCP.

2. Trunks

*1 - Statistical RTP Information is available if remote side is supporting RTCP.

Conditions

 When RTP is closed and opened by hold, transfer, etc., it is saved as a separate 
call.

 The saved RTP information is written to file on SD Card every 1000 calls, once it is 
saved it is deleted from CPU Memory.

 When a write error occurs during save to SD Card, the writing is canceled, and 
deleted from CPU Memory.

 The CPU considers the saving to SD card a low system priority, and does not affect 
other services.

Standard SIP 
Phone

Yes Yes

UT880 Yes No

Table L-3  Trunks

Trunk Type Applied/Not 
Applied System *1 Remarks

Analog Line No

ISDN (BRI) No

ISDN (PRI) No

SIP Line Yes

H323 Yes

CCIS Yes

NetLink Yes

Table L-2  Stations

Terminal Type Applied/Not 
Applied System *1

Applied/Not Applied 
System *2 Remarks
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 When saving the RTP Information to SD card, and 30 MB or less is available on SD 
card, previous RTP files are deleted until 30 MB or more is available. This is 
required to allow the 21 MB for CPU Remote Upgrade.

 When the remote side does not support RTCP, only the RTP information of the 
system side is available. All RTP information on the remote side will be set to 0.

 The RTP Statistical information of VoIP on the Secondary side of Netlink will be 
saved by the Primary system.
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